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capítulo 1

Bienvenidos a Pro Tools M-Powered
Bienvenidos a Pro Tools M-Powered. En esta 
guía se explican los procesos de instalación y 
configuración del software Pro Tools 
M-Powered en sistemas M-Powered.

Un sistema M-Powered consta de los 
componentes básicos siguientes:

• Interfaz de M-Audio aprobada por 
Digidesign (no suministrada)

• Ordenador Windows o Macintosh 
aprobado por Digidesign (no suministrado)

• Software Pro Tools M-Powered 
(suministrado)

Para informarse sobre los ordenadores e 
interfaces M-Audio aprobados por 
Digidesign, consulte el apartado de 
compatibilidad en la página Web de 
Digidesign (www.digidesign.com/compato).
Paquete de Pro Tools 
M-Powered
El paquete del software Pro Tools M-Powered 
incluye:

• El CD de instalación de Pro Tools M-Powered, 
con el programa Pro Tools M-Powered, 
los controladores actualizados de M-Audio, 
los módulos adicionales DigiRack RTAS 
(Real-Time AudioSuite) y AudioSuite, así 
como guías electrónicas en formato PDF

• Llave iLok previamente autorizada para la 
ejecución de Pro Tools M-Powered

• La presente guía, Introducción a Pro Tools 
M-Powered, contiene explicaciones sobre la 
instalación, configuración y aprendizajes 
básicos sobre los sistemas M-Powered

• La Guía básica de M-Powered, concebida para 
que los usuarios nuevos dispongan de unos 
métodos que les permitan realizar tareas 
habituales (por ejemplo, entrada y salida de 
sonido de la interfaz de M-Audio, conexión de 
micrófonos o instrumentos, y grabación de 
sesiones)

• Tarjeta de registro Digidesign
Capítulo 1: Bienvenidos a Pro Tools M-Powered 1
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Funciones de Pro Tools 
M-Powered
El software Pro Tools M-Powered consta de las 
funciones siguientes:

• Reproducción de hasta 32 pistas de audio 
mono digital, o una combinación de 
grabación y reproducción de un máximo 
de 32 pistas de audio mono digital, en 
función de la capacidad del ordenador y la 
interfaz de M-Audio.

• Hasta 128 pistas de audio (con un máximo 
de 32 pistas de voz), 128 pistas de entrada 
auxiliar, 64 pistas de atenuador principal, 
256 pistas MIDI y 32 pistas de instrumento 
por sesión.

• Resolución de audio de 16 o 24 bits, con las 
velocidades de muestreo que pueda admitir 
la interfaz de M-Audio.

• Automatización de mezcla y edición de 
acceso aleatorio, no destructiva

• Procesamiento de audio con hasta 
5 módulos adicionales RTAS por pista, 
según la capacidad del ordenador

• Hasta 5 inserciones por pista

• Hasta 10 envíos por pista

• Hasta 32 buses de mezcla internos

Pro Tools M-Powered utiliza la CPU del 
ordenador para mezclar y procesar pistas 
de audio (procesamiento principal). 
Los ordenadores con velocidades de reloj 
superiores permiten utilizar un mayor 
número de pistas y más módulos 
adicionales.
Introducción a ProTools M-Powered
Diferencias entre Pro Tools 
M-Powered y Pro Tools LE
Pro Tools M-Powered no admite las opciones 
siguientes de Pro Tools LE:

• DigiTranslator

• DV Toolkit

• Superficies de control basadas en Ethernet 
de Digidesign (por ejemplo, Control|24)

• Periféricos de vídeo de Avid

Algunos cuadros de diálogo de configuración de 
Pro Tools M-Powered difieren de los cuadros de 
diálogo de configuración de Pro Tools LE que 
aparecen en la Guía de referencia de Pro Tools. 
Si desea información relativa a los cuadros de 
diálogo de configuración de Pro Tools 
M-Powered, consulte el capítulo 2, 
"Configuración para Windows" o el capítulo 3, 
"Configuración para Macintosh".

Requisitos del sistema
Pro Tools M-Powered se puede usar con una 
interfaz de M-Audio aprobada por Digidesign y 
ejecutarse en un ordenador con la plataforma 
Windows o Macintosh aprobado por 
Digidesign.

Si desea información exhaustiva sobre los 
requisitos del sistema, consulte la página sobre 
compatibilidad en el sitio Web de Digidesign 
(www.digidesign.com/compato).

Información sobre compatibilidad

Digidesign sólo puede asegurar la 
compatibilidad y proporcionar asistencia 
relativa al hardware y al software comprobado y 
aprobado por Digidesign. 



               
Para obtener una lista de ordenadores, sistemas 
operativos, unidades de disco duro y 
dispositivos de otros fabricantes aprobados por 
Digidesign, consulte la información actualizada 
sobre compatibilidad en la página Web de 
Digidesign (www.digidesign.com/compato).

Llave iLok previamente autorizada

El software M-Powered se autoriza con iLok USB 
Smart Key (iLok) de PACE Anti-Piracy.

iLok es similar a una mochila pero, a diferencia 
de ésta, sirve para autorizar de forma segura 
varias aplicaciones de distintos desarrolladores 
de software.

Esta clave puede contener más de 100 
autorizaciones para todo el software que admita 
la iLok. Una vez se haya configurado la iLok para 
autorizar el uso de un determinado programa, 
puede utilizarla para autorizar dicho programa 
en cualquier ordenador.

Pro Tools M-Powered proporciona una llave 
iLok, que se ha autorizado previamente para el 
software Pro Tools M-Powered. 

Llave iLok previamente autorizada

Para poder usar Pro Tools M-Powered, hay 
que insertar esta llave en un puerto USB que 
esté libre.

Para más información sobre la tecnología y 
las autorizaciones de iLok, consulte la guía 
de utilización de iLok en formato PDF.
Requisitos MIDI

Las interfaces MIDI USB dan buenos resultados 
con los sistemas Pro Tools en equipos Windows 
y Macintosh. Las interfaces MIDI serie sólo son 
compatibles con los sistemas Windows.

Si desea obtener una lista de adaptadores 
aprobados, visite la página Web de Digidesign 
(www.digidesign.com).

Requisitos de disco duro

Si desea obtener una lista de discos duros 
aprobados por Digidesign, visite la página Web 
de Digidesign (www.digidesign.com/compato).

Si utiliza una unidad de disco duro ATA/IDE o 
FireWire, iníciela con la aplicación 
Administración de discos (Windows) o con la 
Utilidad de disco que se incluye con el software 
del sistema Apple (Macintosh).

Procure no grabar en el disco duro del 
ordenador

No se recomienda grabar en el disco duro del 
ordenador. Grabar y reproducir en el disco duro 
del ordenador puede disminuir el número de 
pistas y de módulos adicionales que pueden 
utilizarse. 

Únicamente las interfaces MIDI USB son 
compatibles con los sistemas Pro Tools para 
Mac OS X. No lo son los adaptadores de 
puerto de módem a serie ni los dispositivos 
MIDI.

Digidesign no recomienda grabar en la 
unidad interna del ordenador. Grabe en la 
unidad del ordenador sólo cuando sea 
necesario. 
Capítulo 1: Bienvenidos a Pro Tools M-Powered 3
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Espacio de almacenamiento en el disco duro

Las pistas de audio mono que se graben con una resolución de 16 bits a 44,1 kHz (calidad de CD) 
requieren aproximadamente 5 MB de espacio en el disco duro por minuto. Las mismas pistas grabadas 
con una resolución de 24 bits requieren unos 7,5 MB por minuto. 

Las pistas de audio estéreo que se graben con una resolución de 16 bits a 44,1 kHz (calidad de CD) 
requieren aproximadamente 10 MB de espacio en el disco duro por minuto. Las mismas pistas 
grabadas con una resolución de 24 bits requieren unos 15 MB por minuto.

La tabla  1. detalla el espacio de disco duro necesario para almacenar diferentes números de pistas con 
distintas duraciones, a fin de poder calcular la cantidad de espacio de disco duro que está utilizando.
Tabla 1. Espacio necesario en la unidad de disco duro par
Introducción a ProTools M-Powered
a pistas de audio (se muestran sesiones a 44,1 kHz y 

48 kHz)

Número de pistas y duración 16 bits a 
44,1 kHz

16 bits a 
48 kHz

24 bits a 
44,1 kHz

24 bits a 
48 kHz

1 pista mono, 1 minuto 5 MB 5,5 MB 7,5 MB 8,2 MB

1 pista estéreo (o dos pistas 
mono), 5 minutos

50 MB 55 MB 75 MB 83 MB

1 pista estéreo (o dos pistas 
mono), 60 minutos

600 MB 662 MB 900 MB 991 MB

24 pistas mono, 5 minutos 600 MB 662 MB 900 MB 991 MB

24 pistas mono, 60 minutos 7 GB 7,8 GB 10,5 GB 11,6 GB

32 pistas mono, 5 minutos 800 MB 883 MB 1,2 GB 1,3 GB

32 pistas mono, 60 minutos 9,4 GB 10,4 GB 14 GB 15,4 GB



                     
Registro con Digidesign
Consulte la tarjeta de información de registro 
que se incluye y siga las instrucciones para 
registrar su compra online con rapidez. 
El registro de la compra efectuada es la única 
forma de poder recibir asistencia técnica gratuita 
y ofertas de futuras actualizaciones. Es uno de 
los pasos más importantes que se pueden 
emprender como usuario nuevo.

Acerca de las guías de 
Pro Tools
La guía Introducción a Pro Tools M-Powered 
explica los procedimientos de instalación de 
dicho software, así como el uso de una interfaz 
de M-Audio para grabar, editar y mezclar audio y 
pistas MIDI en Pro Tools.

Las guías en pantalla que se suministran con 
Pro Tools M-Powered hacen referencia a los 
sistemas Pro Tools|HD y LE. En general, 
las referencias a Pro Tools LE son válidas 
también para Pro Tools M-Powered, a menos 
que se indique expresamente otra cosa en la 
presente guía o en el apartado sobre 
compatibilidad en la página Web de Digidesign 
(www.digidesign.com/compato).

Si no tiene mucha práctica con las estaciones de 
trabajo digitales, se recomienda la lectura del 
documento siguiente:

• La Guía básica de M-Powered explica pasos 
sencillos para la entrada y salida de sonido de 
M-Audio, la conexión de micrófonos o 
instrumentos, la grabación en una sesión de 
Pro Tools M-Powered, la importación de 
audio desde un CD, la creación de un CD de 
audio a partir de una sesión de Pro Tools 
M-Powered, etcétera.
Para obtener información adicional, consulte las 
siguientes guías en pantalla (.pdf):

• La Guía de referencia de Pro Tools explica el 
funcionamiento del programa Pro Tools 
detalladamente. 

• La Guía de menús de Pro Tools explica todos los 
menús en pantalla de Pro Tools.

• La Guía de módulos adicionales DigiRack 
describe el uso de los módulos adicionales 
RTAS y AudioSuite incluidos en Pro Tools. 

• La Guía de módulos adicionales de Digidesign 
explica cómo utilizar módulos adicionales 
Digidesign optativos.

• La Guía de DigiBase explica detalladamente 
cómo utilizar las bases de datos de Pro Tools 
DigiBase y los navegadores para la gestión de 
datos y medios.

• La guía de métodos abreviados de teclado de 
Pro Tools contiene una lista de métodos 
abreviados de teclado para Pro Tools.

Las versiones en PDF de las guías de Pro Tools se 
instalan automáticamente con Pro Tools 
M-Powered. Se accede a ellas desde el menú Help 
de Pro Tools. Si necesita leer o imprimir las guías 
en PDF, emplee Acrobat Reader o Apple Preview.

Puede adquirir ejemplares impresos de la 
Guía de referencia de Pro Tools; otros 
manuales se pueden adquirir por separado 
en la tienda en línea DigiStore 
(www.digistore.com).
Capítulo 1: Bienvenidos a Pro Tools M-Powered 5
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Convenciones utilizadas en esta 
guía

Las guías de Digidesign usan las convenciones 
que se muestran a continuación para indicar 
selecciones de menús y comandos con teclas:
:

Para llamar la atención sobre información 
importante, se utilizan los símbolos siguientes:

Convención Acción

File > Save En el menú File, elija Save.

Control+N Mantenga pulsada la tecla 
Control y pulse la tecla N.

Control+hacer clic Mantenga pulsada la tecla 
Control y pulse el botón del 
ratón.

Hacer clic con el 
botón derecho 
(Windows)

Haga clic con el botón 
derecho del ratón

Sugerencias para sacar el máximo partido 
del sistema Pro Tools.

Avisos importantes con información que 
puede afectar a los datos o al rendimiento 
del sistema.

Métodos abreviados útiles del teclado o el 
ratón.

Referencias cruzadas que remiten a 
secciones relacionadas de otras guías de 
Digidesign.
Introducción a ProTools M-Powered
Acerca de 
www.digidesign.com
La página Web de Digidesign 
(www.digidesign.com) es la mejor fuente de 
información para poder sacar el máximo partido 
del sistema Pro Tools. A continuación se citan 
sólo algunos de los servicios y funciones 
disponibles. 

Registro Registre online la compra realizada. 
Consulte el formulario que se adjunta para 
disponer de las instrucciones. 

Asistencia Póngase en contacto con el servicio 
de asistencia técnica o de atención al cliente; 
descargue actualizaciones de software y los 
manuales en pantalla más recientes; revise los 
documentos sobre compatibilidad relativos a los 
requisitos del sistema; busque en la base de 
respuestas online; únase a la comunidad de 
usuarios de Pro Tools en la Digidesign User 
Conference. 

Formación y aprendizaje Conviértase en 
operador certificado de Pro Tools o un experto; 
aprenda a distancia gracias a los cursos online o 
infórmese sobre cómo asistir a clase en el aula de 
un centro de formación de Pro Tools certificado. 

Productos y desarrolladores Adquiera 
conocimientos sobre los productos Digidesign; 
descargue versiones de demostración de 
programas, infórmese sobre nuestros 
desarrolladores asociados y sus módulos 
adicionales, aplicaciones y hardware. 

Noticias y acontecimientos Esté siempre al día 
en lo concerniente a Digidesign; adquiera una 
versión de demostración de Pro Tools.

Para más información sobre estos y otros 
recursos de Digidesign, visite la página Web 
(www.digidesign.com). 
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Configuración para Windows
La información de este capítulo sólo es válida 
para sistemas Windows. Si instala Pro Tools 
M-Powered en un ordenador con entorno 
Macintosh, consulte el capítulo 3, 
"Configuración para Macintosh".

Descripción general de la 
instalación
La instalación de Tools M-Powered en un 
ordenador Windows consta de los siguientes 
pasos:

1  "Optimización del sistema Windows" en la 
página 7.

2  "Instalación de la interfaz de M-Audio" en la 
página 12.

3  "Instalación de los controladores de M-Audio" 
en la página 12.

4  "Instalación del software Pro Tools 
M-Powered" en la página 13.

5  "Inicio de Pro Tools M-Powered" en la 
página 15. (En esta fase se incluye la inserción 
de la tarjeta iLok autorizada previamente en un 
puerto USB libre del ordenador.)

Antes de instalar esta versión de 
Pro Tools, consulte el archivo léame 
(Readme) que está en el CD-ROM de 
instalación de Pro Tools M-Powered.
6  "Configuración de Pro Tools M-Powered" en la 
página 15.

7  Establecimiento de las conexiones de audio 
con la interfaz de M-Audio. Para más 
información, consulte la documentación de 
M-Audio.

Optimización del sistema 
Windows
Antes de configurar el ordenador, inicie la 
sesión como administrador en la cuenta que 
desea instalar Pro Tools. Para más información 
al respecto, consulte la documentación de 
Windows.

Optimizaciones obligatorias

Para garantizar un rendimiento óptimo de 
Pro Tools M-Powered, configure los valores 
siguientes antes de instalar Pro Tools.

Cuando haya terminado de cambiar la 
configuración del sistema Windows, 
reinicie el ordenador.
Capítulo 2: Configuración para Windows 7
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Activación del DMA

Al activar DMA (Direct Memory Access, Acceso 
directo a la memoria), se libera ancho de banda 
de la CPU, de forma que el ordenador puede 
realizar otras tareas de Pro Tools.

En la mayoría de los casos, la opción DMA ya 
está correctamente configurada, puesto que 
Windows XP detecta y activa el modo DMA de 
forma predeterminada.

Para activar DMA para cualquier unidad de disco 
duro IDE:

1  Elija Inicio > Panel de control. 

2  En la vista clásica, haga clic en Sistema. 

3  Haga clic en la ficha Hardware.

4  En Administrador de dispositivos, elija 
Administrador de dispositivos.

5  En la ventana Administrador de dispositivos, 
haga doble clic en los controladores IDE 
ATA/ATAPI. A continuación, haga doble clic 
en el canal principal IDE de la unidad de disco 
duro IDE.

6  Haga clic en la ficha Configuración avanzada.

7  En cada dispositivo, configure el modo de 
transferencia en "DMA si está disponible" y haga 
clic en Aceptar.

8  Si hay otros canales IDE, repita los pasos del 
5 al 7.

9  Cierre la ventana Administración de equipos.
Introducción a ProTools M-Powered
Desactivación de Pasar a inactividad y 
Administración de energía

Cuando utilice Pro Tools, establezca la opción 
de energía de modo de espera de Windows en 
Siempre activo. De este modo, se evita que los 
pases de grabación y reproducción de larga 
duración se detengan debido a la falta de 
recursos del sistema. 

Para configurar Administración de energía de 
Windows:

1  Elija Inicio > Panel de control.

2  Haga doble clic en Opciones de energía.

3  Haga clic en la ficha Combinaciones de 
energía.

4  En el menú emergente Combinaciones de 
energía, seleccione Siempre activo.

5  Haga clic en OK. 

De este modo, Pasar a inactividad, El sistema 
hiberna y "Desactivar los discos duros" se 
configuran en Nunca.

Desactivación del suavizado de fuentes 
ClearType

Con Pro Tools se debe desactivar la opción 
"ClearType".

Para desactivar el suavizado de fuentes ClearType:

1  Elija Inicio > Panel de control. 

2  Haga doble clic en Pantalla.

3  Haga clic en la ficha Apariencia.

En los procesadores AMD, compruebe y 
desactive Cool N'Quiet en el BIOS del 
sistema (en la sección de configuración de 
Cool N'Quiet). Consulte la documentación 
del fabricante para saber cómo se desactiva 
esta opción de energía, si es necesario.



4  Haga clic en el botón Efectos.

5  Deseleccione Usar el siguiente método para 
suavizar los bordes de las fuentes de pantalla.

6  Haga clic en Aceptar para guardar la 
configuración y cerrar el cuadro de diálogo 
Efectos.

7  Haga clic en OK.

8  Reinicie el ordenador.

Optimizaciones recomendadas

Otros controladores de hardware y software que 
estén instalados en el ordenador también 
pueden afectar a Pro Tools. Se recomienda llevar 
a cabo las siguientes acciones, si bien no son 
obligatorias:

• Evite la ejecución simultánea de otros 
programas innecesarios con Pro Tools.

• Cierre las utilidades de software que se 
ejecuten en segundo plano, por ejemplo 
Windows Messenger, calendarios y 
programas de mantenimiento de discos. 

• Mientras utiliza Pro Tools, apague todos los 
dispositivos USB que no sean 
imprescindibles. 

• Si la tarjeta de vídeo admite control por 
bus, active la opción correspondiente en 
el panel de control del fabricante. 
Para obtener detalles sobre el 
funcionamiento, consulte la 
documentación del fabricante.

Optimizaciones opcionales

Las siguientes optimizaciones del sistema 
pueden contribuir a un mejor funcionamiento 
de Pro Tools en algunos sistemas. Se recomienda 
usar estas optimizaciones sólo cuando sea 
necesario, ya que pueden repercutir 
negativamente o desactivar el funcionamiento 
de otros programas en el sistema.
Desactivación de tarjetas de red

En caso necesario, desactive cualquier tarjeta de 
red (excepto una tarjeta FireWire que se pudiera 
utilizar para conectar un dispositivo externo al 
sistema).

Para desactivar una tarjeta de red:

1  Con el botón derecho del ratón, haga clic en 
Mi PC y seleccione Administrar.

2  En Herramientas del sistema, seleccione 
Administrador de dispositivos.

3  En la ventana Administrador del sistema, haga 
doble clic en Adaptadores de red; a 
continuación, haga doble clic en la tarjeta de 
adaptador de red que desea desactivar.

4  En el menú emergente Uso del dispositivo de 
la ficha General, elija No utilizar este dispositivo 
(deshabilitar) y haga clic en Aceptar.

5  Cierre la ventana Administración de equipos.

Ajuste de la programación del 
procesador

Para ajustar el rendimiento de la programación del 
procesador:

1  Elija Inicio > Panel de control.

2  En la vista clásica, haga doble clic en Sistema. 

3  Haga clic en la ficha Opciones avanzadas.

4  En el área Rendimiento, haga clic en el botón 
Configuración.

5  En la ventana Opciones de rendimiento, haga 
clic en la ficha Avanzadas.

6  En Programación del procesador, seleccione 
Servicios en segundo plano.

7  En la sección Uso de memoria, seleccione la 
opción Caché del sistema.
Capítulo 2: Configuración para Windows 9
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8  Haga clic en Aceptar para cerrar la ventana 
Opciones de rendimiento. 

9  Haga clic en Aceptar para cerrar la ventana 
Propiedades del sistema.

10  Reinicie el ordenador para que surtan efecto 
los cambios.

Desactivación de Hyper-Threading

Pro Tools LE 7.0 utiliza la potencia de 
procesamiento añadida de los ordenadores con 
varios procesadores o con procesamiento de 
núcleos múltiples o Hyper-Threading, para 
procesamiento RTAS. 

Sin embargo, si establece el número de 
procesadores disponibles para procesamiento 
RTAS en 1 (en el cuadro de diálogo Pro Tools 
Playback Engine), el rendimiento de algunos 
ordenadores con la función Hyper-Threading 
quizá disminuya.

Si esto ocurre, puede aumentar el número de 
procesadores RTAS en el cuadro de diálogo 
Playback Engine, o desactivar la función 
Hyper-Threading en el ordenador. 

Consulte la documentación del ordenador para 
saber cómo se accede al BIOS del sistema y poder 
desactivar Hyper-Threading.

Desactivación de los elementos de 
inicio del sistema

Cuantos menos elementos utilice el ordenador, 
más recursos habrá disponibles para Pro Tools. 
Algunas aplicaciones de inicio pueden consumir 
innecesariamente recursos de la CPU: se deben 
cerrar. 
Introducción a ProTools M-Powered
Tenga cuidado al desactivar uno de los 
elementos de inicio siguientes:

• Número de serie de medio portátil 
(necesario para aplicaciones que utilizan 
una clave de protección contra copia)

• Dispositivos "Plug and Play"

• Registro de sucesos

• Servicios criptográficos

• El cliente DHCP, TCP/IP Net BIOS y otros 
elementos de redes (a menos que el 
ordenador no tenga conexiones de red o 
Internet, en cuyo caso estos elementos 
pueden desactivarse)

Para desactivar los elementos de inicio del 
sistema:

1  En el menú Inicio, elija Ejecutar.

2  Escriba "msconfig" y haga clic en Aceptar. 
Se abre la Utilidad de configuración del sistema.

3  En la ficha General, elija Inicio selectivo.

4  Anule la selección de Cargar elementos de 
inicio y haga clic en Aceptar.

5  Haga clic en Reiniciar para volver a iniciar el 
ordenador.

6  Tras reiniciar, el ordenador muestra un 
mensaje de configuración del sistema. 
Compruebe si ha mejorado el rendimiento de 
Pro Tools antes de desactivar la casilla "No 
volver a mostrar este mensaje". Si no se observa 
ninguna mejora, ejecute "msconfig" y vuelva a 
poner Inicio selectivo en Inicio normal. 
También puede desactivar los elementos de 
inicio y los procesos que no sean 
imprescindibles de uno en uno. 



Configuración y 
mantenimiento del disco duro
Se recomienda que comience con una unidad de 
audio iniciada recientemente. También es 
recomendable que desfragmente 
periódicamente la unidad de audio para 
asegurar un rendimiento constante del sistema.

Procure no grabar en el disco duro del 
ordenador

No se recomienda grabar en el disco duro del 
ordenador. Grabar y reproducir en el disco duro 
del ordenador puede disminuir el número de 
pistas y de módulos adicionales que pueden 
utilizarse.

Cómo formatear una unidad de audio

Para obtener un rendimiento óptimo, las 
unidades de audio deben formatearse como 
FAT32 o NTFS. 

Para formatear una unidad de audio:

1  Con el botón derecho del ratón, haga clic en 
Mi PC y seleccione Administrar. 

2  En Almacenamiento, elija Administración de 
discos.

Haga siempre una copia de seguridad de los 
datos importantes de la unidad antes de 
iniciarla, ya que se borrarán todos los datos 
de la misma.
 3  En la ventana de administración de discos, 

con el botón derecho del ratón haga clic en la 
unidad que vaya a utilizar para el audio y 
seleccione Formatear.

4  Lleve a cabo uno de estos procedimientos: 

• Seleccione la opción Formato rápido. 
Esta opción debe ser suficiente para los 
mecanismos aprobados. 

– o –

• Para conseguir un rendimiento óptimo, 
seleccione 32 K en el menú desplegable de 
tamaño de unidad de asignación 
(compruebe que Quick Format no esté 
seleccionado). Aunque esta opción tarda 
más en finalizar, puede aumentar la eficacia 
en la lectura y escritura de la unidad.

5  Haga clic en el botón Inicio y siga las 
instrucciones en pantalla.

6  Una vez completado el formateo, cierre la 
ventana de formateo. 

Ventana de administración de discos (Windows XP)

Pro Tools sólo admite unidades de tipo 
básico.
Capítulo 2: Configuración para Windows 11
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Limpieza de discos y unidades de audio

El proceso de grabar y editar puede disminuir 
rápidamente el rendimiento global de la unidad. 
Se recomienda que ejecute regularmente la 
función para liberar espacio en disco (o una 
función equivalente) para verificar el estado de 
las unidades y, si es necesario, eliminar los 
archivos temporales y otros datos que no se 
utilizan. 

Para usar la función Liberar espacio en disco: 

1  Elija Inicio > Panel de control.

2  Haga doble clic en Herramientas 
administrativas.

3  Haga doble clic en Administración de equipos.

4  Haga doble clic en Almacenamiento.

5  Haga doble clic en Administración de discos. 

6  Seleccione el volumen apropiado de la lista y, 
a continuación, elija Archivo > Opciones. 

La función Liberar espacio en disco determina 
en el grado en que el estado del disco afecta al 
rendimiento del sistema, y permite detectar y 
eliminar archivos innecesarios del volumen 
seleccionado. Para obtener más información, 
consulte la documentación de Windows XP. 

Cómo desfragmentar una unidad de 
audio

Desfragmente las unidades de audio regularmente 
para mantener un buen rendimiento del 
sistema. 

Para desfragmentar una unidad de audio:

1  Con el botón derecho del ratón, haga clic en 
Mi PC y seleccione Administrar.

2  En Almacenamiento, elija Desfragmentador 
de disco.
Introducción a ProTools M-Powered
3  En la ventana del Desfragmentador de disco, 
elija la unidad que desea desfragmentar

4  Haga clic en el botón Desfragmentar y siga las 
instrucciones en pantalla.

5  Una vez completada la desfragmentación, 
cierre la ventana de administración de equipos.

Instalación de la interfaz de 
M-Audio
Antes de instalar Pro Tools M-Powered, se debe 
instalar la interfaz de M-Audio. Conecte la 
interfaz de M-Audio teniendo en cuenta las 
instrucciones que se proporcionan con ella.

Instalación de los 
controladores de M-Audio
El CD-ROM de instalación de Pro Tools 
M-Powered contiene controladores de M-Audio 
para utilizar interfaces de M-Audio aprobadas 
por Digidesign en Windows XP.

Para instalar el controlador de M-Audio para la 
interfaz de M-Audio:

1  Si utiliza una interfaz FireWire de M-Audio, 
antes de proseguir desconéctela.

2  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered para Windows. 

Pro Tools no reconoce la interfaz de 
M-Audio a menos que se instale el 
controlador de M-Audio que se suministra 
con Pro Tools M-Powered.



3  Busque y abra la carpeta M-Audio Driver 
Installers; a continuación, haga doble clic en el 
controlador correspondiente a su clase de 
interfaz:

• Para las interfaces FireWire de M-Audio, 
haga doble clic en el archivo que comienza 
por "FW_WDM”".

• Para las interfaces PCI de M-Audio, haga 
doble clic en el archivo que comienza por 
"Delta_WDM”".

• Para las interfaces BlackBox de M-Audio, 
haga doble clic en el archivo que comienza 
por "BB_WDM".

• Para Transit de M-Audio, haga doble clic en 
el archivo que comienza por 
"Transit_WDM".

• Para MobilePre de M-Audio, haga doble clic 
en el archivo que comienza por 
"MP_WDM".

• Para FastTrack de M-Audio, haga doble clic 
en el archivo que comienza por 
"FastTrack_WDM".

• Para Ozone de M-Audio, haga doble clic en 
el archivo que comienza por 
"Ozone_WDM".

4  Siga las instrucciones en pantalla para instalar 
el controlador.

5  Una vez completada la instalación, apague el 
ordenador.

6  Si utiliza una interfaz FireWire de M-Audio, 
haga lo siguiente:

• Cuando el equipo esté apagado del todo, 
conecte la interfaz FireWire y enciéndala.

7  Encienda el ordenador.

Si aparece un cuadro de diálogo que indica 
que el controlador no supera la prueba del 
logotipo de Windows, haga clic en 
Continuar.
8  Cuando el sistema reconozca el hardware 
nuevo, ejecute el Asistente para hardware nuevo 
encontrado. Siga las instrucciones en pantalla.

Instalación del software 
Pro Tools M-Powered

Para instalar Pro Tools M-Powered: 

1  Inicie Windows y entre en el sistema con 
privilegios de administrador. Para más 
información al respecto, consulte la 
documentación de Windows.

2  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered para Windows. Vaya a la carpeta del 
programa de instalación de Pro Tools y ábrala. 
A continuación, haga doble clic en el icono de 
instalación.

3  Haga clic en Siguiente para que comience la 
instalación.

4  Seleccione los componentes que desea instalar 
y haga clic en Siguiente.

5  Antes de ir al siguiente paso, espere a que el 
programa de instalación concluya la instalación 
de todos los componentes de software, 
controladores y archivos de sistema PACE. 

6  Una vez completada la instalación, haga clic 
en Finish.

Si se indica que ejecute de nuevo el Asistente 
para hardware nuevo encontrado, hágalo.

En el panel de control de M-Audio, 
compruebe que los canales de salida 1 y 2 
no estén definidos en –Infinity (–∞).

Si aparece un cuadro de diálogo que indica 
que el controlador no supera la prueba del 
logotipo de Windows, haga clic en 
Continuar.
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Instalación de QuickTime

Se requiere QuickTime 6.5 o posterior para 
Pro Tools si tiene previsto incluir archivos de 
vídeo o importar archivos MP3 o MP4 (AAC) en 
las sesiones. QuickTime para Windows XP se 
puede descargar de forma gratuita desde el sitio 
Web de Apple (www.apple.com).

Para instalar QuickTime:

1  Visite el sitio Web de Apple, www.apple.com, 
y acceda a la página de QuickTime.

2  Descargue la aplicación de instalación de 
QuickTime en el ordenador.

3  Haga doble clic en el instalador de QuickTime 
y siga las instrucciones de instalación en 
pantalla.

4  Reinicie el ordenador.

Software opcional en el 
CD-ROM de instalación de 
Pro Tools M-Powered
En el CD-ROM de instalación de Pro Tools 
M-Powered hay varias opciones de software.

Sesión de demostración de 
Pro Tools

El CD-ROM de instalación de Pro Tools 
M-Powered incluye una versión de 
demostración que puede utilizar para verificar el 
buen funcionamiento del sistema.

Antes de instalar la sesión de demostración 
en la unidad de audio, asegúrese de que la 
unidad esté configurada tal como se 
describe en "Cómo formatear una unidad de 
audio" en la página 11.
Introducción a ProTools M-Powered
Para instalar la sesión de demostración:

1  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered. 

2  Desde la unidad de CD-ROM, busque y haga 
doble clic en el icono de instalación de la 
demostración de Pro Tools M-Powered.

3  Defina la unidad de audio como ubicación 
para la instalación y haga clic en Install.

4  Una vez completada la instalación, haga clic 
en Aceptar.

MacDrive

La utilidad MacDrive permite montar unidades 
HFS+ basadas en Macintosh en un sistema 
Pro Tools basado en Windows y utilizarlas como 
unidades de transferencia.

Para instalar la versión de demostración de 
MacDrive que se suministra con Pro Tools:

1  Introduzca el CD de instalación de Pro Tools 
en la unidad de CD-ROM.

2  En la unidad de CD-ROM, localice y abra la 
carpeta Additional Files/MacDrive Demo 
Installer.

3  Haga doble clic en el instalador de 
demostración de MacDrive.

Las unidades de transferencia se pueden 
usar para el almacenamiento, pero no 
para la reproducción ni la grabación. 
Para utilizar archivos de audio basados en 
Mac en un sistema Pro Tools de Windows, 
copie los archivos de la unidad de audio 
HFS+ basada en Mac en una unidad de 
audio NTFS basada en Windows. 



4  Siga las instrucciones en pantalla para instalar 
MacDrive. Una vez completada la instalación, 
reinicie el ordenador.

Inicio de Pro Tools M-Powered
Para utilizar Pro Tools M-Powered con una 
interfaz de M-Audio, siempre se debe disponer 
de una llave iLok con autorización para 
Pro Tools M-Powered. En el paquete de 
Pro Tools M-Powered se suministra una llave 
iLok autorizada previamente.

Para autorizar el programa Pro Tools M-Powered:

1  Inserte la llave iLok autorizada previamente 
en un puerto USB del ordenador que esté libre.

2  Haga doble clic en el acceso directo de 
Pro Tools M-Powered que hay en el escritorio 
(o en la aplicación en Archivos de programa\ 
Digidesign\Pro Tools).

Las tareas de formateo y mantenimiento de 
las unidades HFS+ deben realizarse cuando 
las unidades están conectadas a un 
Macintosh. No use la utilidad MacDrive 
para iniciar o realizar particiones de 
unidades Macintosh.

Durante el inicio o la utilización de 
Pro Tools, no retire la llave iLok.
Configuración de Pro Tools 
M-Powered

Configuraciones del sistema 
Pro Tools

Pro Tools permite ajustar el rendimiento del 
sistema modificando los parámetros del sistema 
que repercuten en la capacidad de 
procesamiento, reproducción y grabación.

En la mayoría de los casos, los parámetros 
predeterminados de configuración del sistema 
brindan el mejor rendimiento posible; aunque 
es posible que desee ajustarlos para adaptarlos a 
sesiones de Pro Tools grandes o que requieren 
mucho procesamiento. 

Tamaño del búfer de hardware

El tamaño de búfer de hardware (H/W Buffer 
Size) controla el tamaño del caché de hardware 
que se emplea en tareas de procesamiento 
principal, por ejemplo, los módulos adicionales 
Real-Time AudioSuite (RTAS). H/W Buffer 
también es válido para gestionar la latencia de 
supervisión.

◆ Al reducir el tamaño del búfer de hardware, 
se reduce la latencia de supervisión; esto resulta 
útil cuando se graban entradas en directo. 

◆ Al aumentar el tamaño del búfer de hardware, 
se aumenta la capacidad de procesamiento de 
audio y efectos; esto resulta útil al mezclar y usar 
más módulos adicionales RTAS.
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Para cambiar el tamaño del búfer de hardware:

1  Elija Setup > Playback Engine. 

2  En el menú desplegable H/W Buffer Size, 
seleccione el tamaño del búfer de hardware en 
muestras.

3  Haga clic en OK.

Procesadores RTAS

La opción RTAS Processors determina el número 
de procesadores del ordenador asignados para el 
procesamiento del módulo adicional RTAS. 

En el caso de los ordenadores con varios 
procesadores o con procesamiento de núcleos 
múltiples o Hyper-Threading, esta opción 
permite activar la posibilidad de varios 
procesadores para los procesos RTAS. La opción 

Aparte de ralentizar la velocidad de 
regeneración en pantalla y la latencia de 
supervisión, unos parámetros de H/W 
Buffer Size más altos pueden aumentar la 
latencia causada por los módulos 
adicionales RTAS, y repercutir en la 
precisión de la automatización de módulos 
adicionales, los datos de silenciamiento y la 
temporización para pistas MIDI.

Cuadro de diálogo Playback Engine para Pro Tools 
M-Powered (se muestra Ozone)
Introducción a ProTools M-Powered
RTAS Processors, utilizada junto con la opción 
CPU Usage Limit, permite controlar el modo en 
que el sistema lleva a cabo el procesamiento 
RTAS y otras tareas de Pro Tools.

◆ Un mayor número de procesadores reserva 
más capacidad de procesamiento de la CPU para 
el procesamiento del módulo adicional RTAS. 
Esto resulta de gran utilidad en sesiones con un 
gran número de módulos adicionales RTAS.

◆ Un número menor de procesadores deja más 
capacidad de procesamiento de la CPU para la 
automatización, las regeneraciones de pantalla y 
la reproducción de vídeo en Pro Tools, o para 
otra aplicación que se esté ejecutando a la vez 
que Pro Tools.

Para definir el número de procesadores RTAS:

1  Elija Setup > Playback Engine.

2  En el menú desplegable RTAS Processors, 
seleccione el número de procesadores que desee 
asignar para el procesamiento del módulo 
adicional RTAS.

3  Haga clic en OK.

Límite de uso de la CPU

La opción CPU Usage Limit controla el 
porcentaje de los recursos de la CPU asignados a 
las tareas de procesamiento principal de 
Pro Tools. La opción CPU Usage Limit, utilizada 
junto con la opción RTAS Processors, permite 
controlar el modo en que el sistema lleva a cabo 
las tareas de Pro Tools.

◆ Un valor de CPU Usage Limit más bajo limita 
el efecto del procesamiento de Pro Tools en otras 
tareas que implican un uso intensivo de la CPU, 
por ejemplo las regeneraciones de pantalla; 
asimismo, resulta útil si el sistema responde con 
lentitud o si otras aplicaciones se ejecutan al 
mismo tiempo que Pro Tools.



◆ Un valor de CPU Usage Limit más alto asigna 
mayor capacidad de procesamiento a Pro Tools; 
resulta útil para reproducir sesiones de gran 
tamaño o utilizar más módulos adicionales en 
tiempo real. 

El valor máximo de CPU Usage Limit depende 
del número de procesadores del ordenador y del 
número de procesadores que especifique para el 
procesamiento RTAS. Este valor puede ir del 85 
por ciento para ordenadores con un procesador, 
al 99 por ciento para ordenadores con varios 
procesadores.

Para cambiar el límite de uso de la CPU:

1  Elija Setup > Playback Engine. 

2  En el menú desplegable CPU Usage Limit, 
seleccione el porcentaje de procesamiento de la 
CPU que desee asignar a Pro Tools. 

3  Haga clic en OK. 

Tamaño del búfer de reproducción DAE

La opción DAE Playback Buffer Size determina la 
cantidad de memoria que DAE emplea para 
búferes de disco. El valor óptimo de DAE 
Playback Buffer Size para la mayoría de las 
operaciones del disco es Level 2. 

◆ Las configuraciones de DAE Playback Buffer 
Size inferiores a Level 2 pueden mejorar la 
velocidad de inicio de reproducción y 
grabación, pero pueden dificultar la 
reproducción o grabación de pistas de forma 
fiable en sesiones que contengan una gran 
cantidad de pistas o una mayor densidad de 
edición, o en sistemas que tengan unidades de 
disco fragmentadas más lentas o pesadas.

Un aumento del valor de la opción CPU 
Usage Limit puede disminuir la velocidad 
de regeneración en pantalla de los 
ordenadores más lentos.
◆ Si configura DAE Playback Buffer Size con un 
valor superior a Level 2, permitirá una mayor 
densidad de edición en una sesión o un mayor 
número de pistas al utilizar unidades de disco 
duro más lentas. Sin embargo, un valor más 
elevado también puede ralentizar el inicio de la 
reproducción o la grabación, o un retraso 
audible más prolongado al editar durante la 
reproducción.

Para cambiar el tamaño del búfer de 
reproducción DAE:

1  Elija Setup > Playback Engine.

2  En el menú desplegable Size del recuadro DAE 
Playback Buffer, seleccione un tamaño de búfer.

3  Haga clic en OK.

Configuración del hardware de 
Pro Tools y el panel de control de 
M-Audio

El cuadro de diálogo Hardware Setup de 
Pro Tools (Setups > Hardware Setup) muestra el 
nombre del periférico de M-Audio. Asimismo, 
indica las funciones de hardware que se pueden 
modifica en el panel de control de M-Audio.

En el panel de control de M-Audio se puede 
cambiar la configuración de las áreas siguientes:

• Configuración del mezclador

• Configuración de la salida

Si utiliza un valor más elevado de DAE 
Playback Buffer Size, dejará menos 
memoria del sistema para otras tareas. 
Se recomienda utilizar el valor 
predeterminado de Level 2, a menos que se 
produzcan errores -9073 de disco 
demasiado lento o fragmentado. 
Capítulo 2: Configuración para Windows 17
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• Configuración del hardware (velocidad de 
muestreo, tamaño de búfer de hardware y 
fuente de sincronización)

Para cambiar la configuración del panel de control 
de M-Audio:

1  Si Pro Tools M-Powered está ejecutándose, 
ciérrelo.

2  Elija Inicio > Panel de control. 

3  Inicie el panel de control de M-Audio de la 
forma siguiente:

• Para interfaces FireWire, inicie M-Audio 
FW Audio.

• Para interfaces PCI, inicie M-Audio Delta 
Audio.

• Para interfaces USB, inicie el panel de 
control de M-Audio con el nombre de la 
interfaz.

4  Para cambiar la configuración en el panel de 
control de M-Audio, consulte la documentación 
que se suministra con dicha interfaz.

5  Cuando haya concluido, cierre el panel de 
control de M-Audio.

La frecuencia de muestreo se puede 
modificar al crear una sesión de Pro Tools 
seleccionando una frecuencia distinta en el 
cuadro de diálogo New Session. Para más 
información, consulte la Guía de referencia 
de Pro Tools.
Introducción a ProTools M-Powered
Fuente de sincronización (Pro Tools 
Clock Source)

Si la interfaz de M-Audio tiene una E/S digital 
(por ejemplo S/PDIF), use el panel de control de 
M-Audio para seleccionar la fuente de 
sincronización del sistema.

Para seleccionar la fuente de sincronización:

1  Si Pro Tools M-Powered está ejecutándose, 
ciérrelo.

2  Elija Inicio > Panel de control. 

3  Inicie el panel de control de M-Audio de la 
forma siguiente:

• Para interfaces FireWire, inicie M-Audio 
FW Audio.

• Para interfaces PCI, inicie M-Audio Delta 
Audio.

• Para interfaces USB, inicie el panel de 
control de M-Audio con el nombre de la 
interfaz.

4  Haga clic en la ficha Hardware.

5  Seleccione una fuente de sincronización.

6  Haga clic en OK.

En Pro Tools M-Powered, la fuente de 
sincronización no se puede definir en la 
ventana Session Setup de Pro Tools.

El dispositivo de entrada digital debe estar 
conectado y encendido. Si no lo está, deje la 
opción de fuente de sincronización en 
Internal.

Para más información sobre la selección de 
la fuente de sincronización de la interfaz de 
M-Audio, consulte la documentación de 
dicha interfaz.



Supervisión con baja latencia

La supervisión directa o con baja latencia no 
está disponible en Pro Tools M-Powered.

Sin embargo, si los dispositivos de M-Audio 
cuyos mezcladores del panel de control tienen la 
función de supervisión directa, dicha función se 
puede usar para baja latencia mientras se graba 
en Pro Tools. 

Para utilizar la función de supervisión directa del 
mezclador de M-Audio durante la grabación:

1  En Pro Tools, active para grabar las pistas que 
desee grabar y silencie su salida.

2  Abra el panel de control de M-Audio Control 
Panel para la interfaz de M-Audio.

3  En el mezclador del panel de control de la 
interfaz, dirija los canales de entrada que desee 
supervisar a las salidas principales del mezclador 
(suelen ser las salidas 1–2) haciendo clic en el 
control de salida correspondiente.

Mezclador del panel de control de FireWire 410 de la 
interfaz M-Audio

Control de la salida 1–2 del mezclador
4  Ajuste el nivel de salida y el equilibrio 
mediante los controladores de panorámico de 
audio y volumen del mezclador del panel de 
control. 

5  En Pro Tools, comience a grabar.

6  Para escuchar las pistas grabadas, anule el 
silenciamiento de las pistas en Pro Tools e inicie 
la reproducción.

7  Cuando haya finalizado la grabación, 
desactive el control de salida del mezclador del 
mezclador del panel de control.

Configuración de I/O Setup

En el cuadro de diálogo I/O Setup, se pueden 
etiquetar las rutas de señal de entradas, salidas, 
inserciones y de bus de Pro Tools. El cuadro de 
diálogo I/O Setup proporciona una 
representación gráfica de las entradas, salidas y 
rutas de señal de la interfaz de M-Audio. 

Pro Tools MM-Powered tiene una configuración 
de E/S predeterminada que permite comenzar a 
trabajar con el programa. Use el cuadro de 
diálogo de configuración de E/S sólo si desea 
cambiar el nombre de las rutas de entrada y 
salida predeterminadas.

El panel de control de M-Audio puede dejarse 
abierto mientras se trabaja con Pro Tools 
M-Powered.

Pro Tools M-Powered omite el mezclador de 
M-Audio que aparece en el panel de control 
de M-Audio. Las entradas y salidas de 
hardware de la interfaz aparecen 
directamente en el cuadro de diálogo I/O 
Setup de Pro Tools.
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Para cambiar el nombre de las rutas de E/S en el 
cuadro de diálogo de configuración de E/S:

1  Elija Setup > I/O.

2  Haga clic en la ficha Input, Output, Insert o 
Bus para ver el tipo conexiones 
correspondientes.

3  Para cambiar el nombre de una ruta o subruta, 
haga doble clic directamente en el nombre de la 
ruta, escriba un nuevo nombre y pulse la tecla 
Intro. 

4  Haga clic en OK.

MIDI Studio Setup

(opcional)

Si va a utilizar dispositivos MIDI con Pro Tools, 
defina las opciones de MIDI con la función 
MIDI Studio Setup. Consulte apéndice A, 
"Configuración de MIDI Studio Setup 
(sólo Windows)" para más información.

Cuadro de diálogo I/O Setup para Pro Tools M-Powered 
(se muestra la interfaz FireWire de M-Audio)

Consulte la Guía de referencia de Pro Tools 
(o elija Help > Pro Tools Reference Guide) 
para más información sobre cómo cambiar 
el nombre de rutas de E/S.
Introducción a ProTools M-Powered
Copia de seguridad de la 
configuración del sistema

Una vez configurado el sistema y Pro Tools, 
debe guardar una imagen de la unidad del 
sistema con una utilidad de copia de seguridad 
como Norton Ghost. De este modo, podrá 
restaurar rápidamente la configuración del 
sistema en caso de producirse algún problema.

Desinstalación de Pro Tools 
M-Powered
Para desinstalar el software Pro Tools 
M-Powered del ordenador, utilice el comando 
Agregar o quitar programas.

Para desinstalar Pro Tools del ordenador:

1  Elija Inicio > Panel de control. 

2  Inicie Agregar o quitar programas.

3  En Programas actualmente instalados, 
seleccione Digidesign Pro Tools M-Powered.

4  Haga clic en el botón Cambiar o quitar.

5  Para desinstalar Pro Tools M-Powered, siga las 
instrucciones en pantalla.



capítulo 3

Configuración para Macintosh
La información de este capítulo sólo es válida 
para sistemas Macintosh. Si instala Pro Tools 
M-Powered en un ordenador con entorno 
Windows, consulte el capítulo 2, 
"Configuración para Windows".

Descripción general de la 
instalación
La instalación de Tools M-Powered en un 
ordenador Macintosh consta de los siguientes 
pasos:

1  "Optimización del sistema Macintosh" en la 
página 21.

2  "Instalación de la interfaz de M-Audio" en la 
página 24.

3  "Instalación de los controladores de M-Audio" 
en la página 24.

4  "Instalación del software Pro Tools 
M-Powered" en la página 24.

5  "Inicio de Pro Tools M-Powered" en la 
página 25. (En esta fase se incluye la inserción 
de la tarjeta iLok autorizada previamente en un 
puerto USB libre del ordenador.)

Antes de instalar esta versión de Pro Tools, 
consulte el archivo léame (Readme) que está 
en el CD-ROM de instalación de Pro Tools 
M-Powered.
6  "Configuración de Pro Tools M-Powered" en la 
página 25.

7  Establecimiento de las conexiones de audio 
con la interfaz de M-Audio. Para más 
información, consulte la documentación de 
M-Audio.

Optimización del sistema 
Macintosh

Para asegurar un rendimiento óptimo con 
Pro Tools, configure el ordenador antes de 
instalar el hardware y el software Pro Tools.

Antes de configurar el ordenador, inicie la 
sesión como administrador en la cuenta que 
desea instalar Pro Tools. Para información sobre 
los privilegios de administrador en Mac OS X, 
consulte la documentación de Apple OS X. 

No utilice la función de actualización 
automática del software de Mac OS X, 
ya que podría actualizar su sistema con 
una versión de Mac OS que aún no 
haya sido aprobado por Pro Tools. 
Para obtener información sobre versiones 
aprobadas de Mac OS, consulte la 
información de compatibilidad 
actualizada del sitio Web de Digidesign 
(www.digidesign.com/compato).
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Desactivación de la actualización de 
software

Para desactivar la función Actualización de 
Software:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Actualización de Software. 

2  Haga clic en Actualización de Software y anule 
la selección de Buscar actualizaciones.

Desactivación del Economizador

Para desactivar la función de Economizador:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Economizador.

2  Haga clic en Reposo y haga lo siguiente:

• Configure la opción de reposo del 
ordenador en Nunca.

• Configure la opción de reposo de la 
pantalla en Nunca.

• Anule la selección de Poner el disco en 
reposo cuando sea posible.

Configuración del rendimiento del 
procesador

(sólo ordenadores con Macintosh G5)

Para definir el rendimiento del procesador:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Economizador.

2  Haga clic en Opciones y configure el 
rendimiento del procesador con el valor 
más alto.
Introducción a ProTools M-Powered
Desactivación de los índices de 
Spotlight

La función Spotlight de Mac OS X crea un índice 
de los archivos y carpetas en el fondo, lo cual 
repercute en el rendimiento del sistema. 
Se recomienda desactivar la creación del índice 
de Spotlight antes de utilizar Pro Tools.

Para desactivar la función de índice de Spotlight:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Spotlight. 

2  En la ventana Spotlight, elija Privacidad.

3  Para evitar la creación de índice de una 
unidad, arrastre su icono del escritorio a la lista.

Desactivación de funciones rápidas de 
teclado de Spotlight

La función Spotlight de Mac OS X utiliza los 
mismos comandos de teclas que Pro Tools para 
iniciar la grabación (Comando+Barra 
espaciadora), y para grabar online 
(Comando+Opción+Barra espaciadora). 
Si desea seguir utilizando estos comandos de 
teclas en Pro Tools, debe desactivar estas 
funciones rápidas de teclado.

Para desactivar la función rápida de teclado para 
Spotlight:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Spotlight. 

2  Anule la selección de Función rápida de 
teclado para el menú Spotlight y Función rápida 
de teclado para la ventana Spotlight.



Desactivación de la función rápida de 
teclado de Dashboard

La función Dashboard de Mac OS X utiliza el 
mismo comando de tecla que utiliza Pro Tools 
para iniciar la grabación (F12). Si desea seguir 
utilizando este comando de tecla en Pro Tools, 
debe desactivar esta función rápida de teclado.

Para desactivar la función rápida de teclado para 
Dashboard:

1  Elija Preferencias del Sistema en el menú 
Apple y haga clic en Dashboard y Exposé. 

2  Configure la función rápida de teclado de 
Dashboard en "–".

Configuración y 
mantenimiento del disco duro
Se recomienda que comience con una unidad de 
audio recientemente iniciada.

Procure no grabar en el disco duro del 
ordenador

No se recomienda grabar en el disco duro del 
ordenador. Grabar y reproducir en el disco duro 
del ordenador puede disminuir el número de 
pistas y de módulos adicionales que pueden 
utilizarse, así como producir errores de disco.

Cómo formatear una unidad de audio

Para obtener un rendimiento óptimo, las 
unidades de audio deben formatearse como 
Mac OS Extended (Journaled). 

Haga siempre una copia de seguridad de los 
datos importantes de la unidad antes de 
iniciarla, ya que se borrarán todos los datos 
de la misma.
Para formatear una unidad de audio: 

1  Inicie la aplicación Utilidad de disco, 
en Aplicaciones/Utilidades.

2  Haga clic en la ficha Borrar. 

3  Seleccione la unidad que desee iniciar en la 
columna de la izquierda de la ventana. 

4  Elija el formato Mac OS Extended (Journaled). 

5  Escriba un nombre para el nuevo volumen. 

6  Si tiene previsto conectar la unidad a un 
ordenador Mac OS 9, seleccione la opción para 
instalar controladores de Mac OS 9. 

7  Haga clic en Borrar.

La unidad aparece en el escritorio con el nuevo 
nombre de volumen.

Utilidad de disco (Mac OS X)

No elija la opción de formato para 
distinguir entre mayúsculas y minúsculas. 
Pro Tools no funciona correctamente con 
las unidades que distinguen entre 
mayúsculas y minúsculas.
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Instalación de la interfaz de 
M-Audio
Antes de instalar Pro Tools M-Powered, se debe 
instalar la interfaz de M-Audio. Conecte la 
interfaz de M-Audio teniendo en cuenta las 
instrucciones que se proporcionan con ella.

Instalación de los 
controladores de M-Audio
El CD-ROM de instalación de Pro Tools 
M-Powered contiene controladores de M-Audio 
para utilizar interfaces de M-Audio aprobadas 
por Digidesign en Macintosh.

Para instalar el controlador de M-Audio para la 
interfaz de M-Audio:

1  Si utiliza una interfaz FireWire de M-Audio, 
antes de proseguir desconéctela.

2  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered para Macintosh. 

3  Busque y abra la carpeta M-Audio Driver 
Installers; a continuación, haga doble clic en el 
controlador correspondiente a su clase de 
interfaz:

• Para las interfaces FireWire de M-Audio, 
haga doble clic en el archivo que comienza 
por "FireWire_OSX".

• Para las interfaces PCI de M-Audio, haga 
doble clic en el archivo que comienza por 
"Delta_OSX".

• Para las interfaces BlackBox de M-Audio, 
haga doble clic en el archivo que comienza 
por "BlackBox_OSX".

Pro Tools no reconoce la interfaz de 
M-Audio a menos que se instale el 
controlador de M-Audio que se suministra 
con Pro Tools M-Powered.
Introducción a ProTools M-Powered
• Para Transit de M-Audio, haga doble clic en 
el archivo que comienza por "Transit_OSX".

• Para MobilePre de M-Audio, haga doble clic 
en el archivo que comienza por 
"MobilePre_OSX".

• Para FastTrack de M-Audio, haga doble clic 
en el archivo que comienza por 
"FastTrack_OSX".

• Para Ozone de M-Audio, haga doble clic en 
el archivo que comienza por "Ozone_OSX".

4  Siga las instrucciones en pantalla para instalar 
el controlador.

5  Una vez completada la instalación, apague el 
ordenador.

6  Si utiliza una interfaz FireWire de M-Audio, 
haga lo siguiente:

• Cuando el equipo esté apagado del todo, 
conecte la interfaz FireWire y enciéndala.

7  Encienda el ordenador.

Instalación del software 
Pro Tools M-Powered
Tras la configuración de los parámetros del 
sistema Apple y la instalación de la interfaz y los 
controladores de M-Audio, Pro Tools 
M-Powered ya se puede instalar.

Para instalar Pro Tools M-Powered:

1  Inicie la sesión como administrador en la 
cuenta en que desea instalar Pro Tools. Para más 
información sobre los privilegios de 
administrador en Mac OS X, consulte la 
documentación de Mac OS X de Apple. 

En el panel de control de M-Audio, 
compruebe que los canales de salida 1 y 2 
no estén definidos en –Infinity (–∞).



2  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered para Macintosh. Haga doble clic en 
"Install Pro Tools M-Powered".

3  Introduzca su contraseña de administrador y 
haga clic en OK para autenticar la instalación. 

4  Siga las instrucciones en pantalla para 
continuar y aceptar la instalación.

5  En la ventana del programa de instalación, 
elija Custom Install en el menú emergente y 
haga clic en Install. 

6  Para instalar Pro Tools, siga el resto de las 
instrucciones en pantalla.

7  Una vez completada la instalación, haga clic 
en el botón para reiniciar.

Software opcional en el 
CD-ROM de instalación de 
Pro Tools M-Powered
El CD-ROM de instalación de Pro Tools 
M-Powered incluye instaladores independientes 
para los siguientes elementos opcionales. 

Sesión de demostración de 
Pro Tools

El CD-ROM de instalación de Pro Tools 
M-Powered incluye una sesión de demostración 
que puede utilizar para verificar el buen 
funcionamiento de su sistema. 

Para instalar la sesión de demostración:

1  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered. Busque y haga doble clic en el icono 
de instalación de la demostración de Pro Tools 
M-Powered.
2  Seleccione la unidad de audio como ubicación 
de instalación y haga clic en el botón para 
instalar.

3  Una vez completada la instalación, salga del 
programa de instalación.

Inicio de Pro Tools M-Powered
Para utilizar Pro Tools M-Powered con una 
interfaz de M-Audio, siempre se debe disponer 
de una llave iLok con autorización para 
Pro Tools M-Powered. En el paquete de 
M-Powered se suministra una llave iLok 
autorizada previamente.

Para autorizar el programa Pro Tools M-Powered:

1  Inserte la llave iLok autorizada previamente 
en un puerto USB del ordenador que esté libre.

2  Haga clic en el icono de Pro Tools M-Powered 
en la barra de aplicaciones (o en la aplicación en 
Applications\Digidesign\Pro Tools).

Configuración de Pro Tools 
M-Powered

Configuraciones del sistema 
Pro Tools

Pro permite ajustar el rendimiento del sistema 
modificando los parámetros del sistema que 
repercuten en la capacidad de procesamiento, 
reproducción y grabación. 

Durante el inicio o la utilización de 
Pro Tools, no retire la llave iLok.
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En la mayoría de los casos, los parámetros 
predeterminados de configuración del sistema 
brindan el mejor rendimiento posible; aunque 
es posible que desee ajustarlos para adaptarlos a 
sesiones de Pro Tools grandes o que requieren 
mucho procesamiento. 

Tamaño del búfer de hardware

El tamaño de búfer de hardware (H/W Buffer 
Size) controla el tamaño del caché de hardware 
que se emplea en tareas de procesamiento 
principal, por ejemplo, los módulos adicionales 
Real-Time AudioSuite (RTAS). H/W Buffer 
también es válido para gestionar la latencia de 
supervisión.

◆ Al reducir el tamaño del búfer de hardware, 
se reduce la latencia de supervisión; esto resulta 
útil cuando se graban entradas en directo. 

◆ Al aumentar el tamaño del búfer de hardware, 
se aumenta la capacidad de procesamiento de 
audio y efectos; esto resulta útil al mezclar y usar 
más módulos adicionales RTAS.

Para cambiar el tamaño del búfer de hardware:

1  Elija Setup > Playback Engine. 

2  En el menú desplegable H/W Buffer Size, 
seleccione el tamaño del búfer de hardware en 
muestras.

3  Haga clic en OK. 

Aparte de ralentizar la velocidad de 
regeneración en pantalla y la latencia de 
supervisión, unos parámetros de H/W 
Buffer Size más altos pueden aumentar la 
latencia causada por los módulos 
adicionales RTAS, y repercutir en la 
precisión de la automatización de módulos 
adicionales, los datos de silenciamiento y la 
temporización para pistas MIDI.
Introducción a ProTools M-Powered
Procesadores RTAS

La opción RTAS Processors determina el número 
de procesadores del ordenador asignados para el 
procesamiento del módulo adicional RTAS. 

En el caso de los ordenadores con varios 
procesadores o con procesamiento de núcleos 
múltiples o Hyper-Threading, esta opción 
permite activar la posibilidad de varios 
procesadores para los procesos RTAS. La opción 
RTAS Processors, utilizada junto con la opción 
CPU Usage Limit, permite controlar el modo en 
que el sistema lleva a cabo el procesamiento 
RTAS y otras tareas de Pro Tools.

◆ Un mayor número de procesadores reserva 
más capacidad de procesamiento de la CPU para 
el procesamiento del módulo adicional RTAS. 
Esto resulta de gran utilidad en sesiones con un 
gran número de módulos adicionales RTAS.

◆ Un número menor de procesadores deja más 
capacidad de procesamiento de la CPU para la 
automatización, las regeneraciones de pantalla y 
la reproducción de vídeo en Pro Tools, o para 
otra aplicación que se esté ejecutando a la vez 
que Pro Tools.

Cuadro de diálogo Playback Engine para Pro Tools 
M-Powered (se muestra la interfaz FireWire 410 
de M-Audio)



Para cambiar el número de procesadores RTAS:

1  Elija Setup > Playback Engine.

2  En el menú desplegable RTAS Processors, 
seleccione el número de procesadores que desee 
asignar para el procesamiento del módulo 
adicional RTAS.

3  Haga clic en OK.

Límite de uso de la CPU

La opción CPU Usage Limit controla el 
porcentaje de los recursos de la CPU asignados a 
las tareas de procesamiento principal de 
Pro Tools. La opción CPU Usage Limit, utilizada 
junto con la opción RTAS Processors, permite 
controlar el modo en que el sistema lleva a cabo 
las tareas de Pro Tools.

◆ Un valor de CPU Usage Limit más bajo limita 
el efecto del procesamiento de Pro Tools en otras 
tareas que implican un uso intensivo de la CPU, 
por ejemplo las regeneraciones de pantalla; 
asimismo, resulta útil si el sistema responde con 
lentitud o si otras aplicaciones se ejecutan al 
mismo tiempo que Pro Tools.

◆ Un valor de CPU Usage Limit más alto asigna 
mayor capacidad de procesamiento a Pro Tools; 
resulta útil para reproducir sesiones de gran 
tamaño o utilizar más módulos adicionales en 
tiempo real. 

El valor máximo de CPU Usage Limit depende 
del número de procesadores del ordenador y del 
número de procesadores que especifique para el 
procesamiento RTAS. Este valor puede ir del 
85 por ciento para ordenadores con un 
procesador, al 99 por ciento para ordenadores 
con varios procesadores.

Un aumento del valor de la opción CPU 
Usage Limit puede disminuir la velocidad 
de regeneración en pantalla de los 
ordenadores más lentos.
Para cambiar el límite de uso de la CPU:

1  Elija Setup > Playback Engine. 

2  En el menú desplegable CPU Usage Limit, 
seleccione el porcentaje de procesamiento de la 
CPU que desee asignar a Pro Tools. 

3  Haga clic en OK.

Tamaño del búfer de reproducción DAE

La opción DAE Playback Buffer Size determina la 
cantidad de memoria que DAE emplea para 
búferes de disco. El valor óptimo de DAE 
Playback Buffer Size para la mayoría de las 
operaciones del disco es Level 2. 

◆ Las configuraciones de DAE Playback Buffer 
Size inferiores a Level 2 pueden mejorar la 
velocidad de inicio de reproducción y 
grabación, pero pueden dificultar la 
reproducción o grabación de pistas de forma 
fiable en sesiones que contengan una gran 
cantidad de pistas o una mayor densidad de 
edición, o en sistemas que tengan unidades de 
disco fragmentadas más lentas o pesadas.

◆ Si configura DAE Playback Buffer Size con un 
valor superior a Level 2, permitirá una mayor 
densidad de edición en una sesión o un mayor 
número de pistas al utilizar unidades de disco 
duro más lentas. Sin embargo, un valor más 
elevado también puede ralentizar el inicio de la 
reproducción o la grabación, o un retraso 
audible más prolongado al editar durante la 
reproducción.

Si utiliza un valor más elevado de DAE 
Playback Buffer Size, dejará menos 
memoria del sistema para otras tareas. 
Se recomienda utilizar el valor 
predeterminado de Level 2, a menos que se 
produzcan errores -9073 de disco 
demasiado lento o fragmentado. 
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Para cambiar el tamaño del búfer de 
reproducción DAE:

1  Elija Setup > Playback Engine.

2  En el menú desplegable Size del recuadro DAE 
Playback Buffer, seleccione un tamaño de búfer.

3  Haga clic en OK. 

Configuración del hardware de 
Pro Tools y el panel de control de 
M-Audio

El cuadro de diálogo Hardware Setup de Pro Tools 
(Setups > Hardware Setup) muestra el nombre del 
periférico de M-Audio. Asimismo, muestra un 
mensaje para indicar que en el panel de control 
de M-Audio se pueden modificar varias funciones 
de hardware.

En el panel de control de M-Audio se puede 
cambiar la configuración de las áreas siguientes:

• Configuración del mezclador

• Configuración de la salida

• Configuración del hardware (velocidad de 
muestreo, tamaño de búfer de hardware y 
fuente de sincronización)

Para cambiar la configuración del panel de control 
de M-Audio:

1  Si Pro Tools M-Powered está ejecutándose, 
ciérrelo.

2  En la carpeta Applications, busque e inicie el 
panel de control de M-Audio de la forma 
siguiente:

La frecuencia de muestreo se puede 
modificar al crear una sesión de Pro Tools 
seleccionando una frecuencia distinta en el 
cuadro de diálogo New Session. Para más 
información, consulte la Guía de referencia 
de Pro Tools.
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• Para interfaces FireWire, inicie M-Audio 
FireWire.

• Para interfaces PCI, inicie el panel de 
control de M-Audio Delta.

• Para interfaces USB, inicie el panel de 
control de M-Audio con el nombre de la 
interfaz.

3  Para cambiar la configuración en el panel de 
control de M-Audio, consulte la documentación 
que se suministra con dicha interfaz.

4  Cuando haya concluido, cierre el panel de 
control de M-Audio.

Fuente de sincronización (Pro Tools 
Clock Source)

Si la interfaz de M-Audio tiene una E/S digital 
(por ejemplo S/PDIF), use el panel de control de 
M-Audio para seleccionar la fuente de 
sincronización del sistema.

Para seleccionar la fuente de sincronización:

1  Si Pro Tools M-Powered está ejecutándose, 
ciérrelo.

2  En la carpeta Applications, busque e inicie el 
panel de control de M-Audio de la forma 
siguiente:

• Para interfaces FireWire, inicie M-Audio FW.

• Para interfaces PCI, inicie el panel de 
control de M-Audio Delta.

• Para interfaces USB, inicie el panel de 
control de M-Audio con el nombre de la 
interfaz.

3  Haga clic en la ficha Hardware.

En Pro Tools M-Powered, la fuente de 
sincronización no se puede definir en la 
ventana Session Setup de Pro Tools.



4  Seleccione una fuente de sincronización.

5  Cuando haya concluido, cierre el panel de 
control de M-Audio.

Supervisión con baja latencia

La supervisión directa o con baja latencia no 
está disponible en Pro Tools M-Powered.

Sin embargo, si los dispositivos de M-Audio 
cuyos mezcladores del panel de control tienen la 
función de supervisión directa, dicha función se 
puede usar para baja latencia mientras se graba 
en Pro Tools. 

Para utilizar la función de supervisión directa del 
mezclador de M-Audio durante la grabación:

1  En Pro Tools, active para grabar las pistas que 
desee grabar y silencie su salida.

2  Abra el panel de control de M-Audio Control 
Panel para la interfaz de M-Audio.

3  En el mezclador del panel de control de la 
interfaz, dirija los canales de entrada que desee 
supervisar a las salidas principales del mezclador 
(suelen ser las salidas 1–2) haciendo clic en el 
control de salida correspondiente.

El dispositivo de entrada digital debe estar 
conectado y encendido. Si no lo está, deje la 
opción de fuente de sincronización en 
Internal.

Para más información sobre la selección de 
la fuente de sincronización de la interfaz de 
M-Audio, consulte la documentación de 
dicha interfaz.
4  Ajuste el nivel de salida y el equilibrio 
mediante los controladores de panorámico de 
audio y volumen del mezclador del panel de 
control. 

5  En Pro Tools, comience a grabar.

6  Para escuchar las pistas grabadas, anule el 
silenciamiento de las pistas en Pro Tools e inicie 
la reproducción.

7  Cuando haya finalizado la grabación, 
desactive el control de salida del mezclador del 
mezclador del panel de control.

Mezclador del panel de control de FireWire 410 de la 
interfaz M-Audio

El panel de control de M-Audio puede dejarse 
abierto mientras se trabaja con Pro Tools 
M-Powered.

Control de la salida 1–2 del mezclador
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Configuración de I/O Setup

En el cuadro de diálogo I/O Setup, se pueden 
etiquetar las rutas de señal de entradas, salidas, 
inserciones y de bus de Pro Tools. El cuadro de 
diálogo I/O Setup proporciona una 
representación gráfica de las entradas, salidas y 
rutas de señal de la interfaz de M-Audio. 

Pro Tools M-Powered tiene una configuración 
de E/S predeterminada que permite comenzar a 
trabajar con el programa. Use el cuadro de 
diálogo de configuración de E/S sólo si desea 
cambiar el nombre de las rutas de entrada y 
salida predeterminadas.

Para cambiar el nombre de las rutas de E/S en el 
cuadro de diálogo de configuración de E/S:

1  Elija Setup > I/O.

Pro Tools M-Powered omite el mezclador de 
M-Audio que aparece en el panel de control 
de M-Audio. Las entradas y salidas de 
hardware de la interfaz aparecen 
directamente en el cuadro de diálogo I/O 
Setup de Pro Tools.

Cuadro de diálogo I/O Setup para Pro Tools M-Powered 
(se muestra la interfaz FireWire 1814 de M-Audio) 
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2  Haga clic en la ficha Input, Output, Insert o 
Bus para ver el tipo conexiones 
correspondientes.

3  Para cambiar el nombre de una ruta o subruta, 
haga doble clic directamente en el nombre de la 
ruta, escriba otro nombre y pulse la tecla 
Retorno. 

4  Haga clic en OK.

Audio MIDI Setup (AMS)

(opcional)

Si va a utilizar dispositivos MIDI con Pro Tools, 
defina las opciones de MIDI con la función de 
configuración de MIDI y audio de Apple: Audio 
MIDI Setup (AMS). Consulte apéndice B, 
"Configuración de AMS (sólo en Mac OS X)" 
para más información. 

Copia de seguridad de la 
configuración del sistema

Una vez configurado el sistema y Pro Tools, 
debe guardar una imagen de la unidad del 
sistema con una utilidad de copia de 
seguridad como Bombich Carbon Copy Cloner. 
De este modo, podrá restaurar rápidamente la 
configuración del sistema en caso de producirse 
algún problema.

Consulte la Guía de referencia de Pro Tools 
(o elija Help > Pro Tools Reference Guide) 
para más información sobre cómo cambiar 
el nombre de rutas de E/S.



Desinstalación de Pro Tools 
M-Powered
Para desinstalar el software Pro Tools 
M-Powered del ordenador, utilice el archivo de 
instalación que viene en el CD-ROM de 
instalación. 

Para desinstalar Pro Tools del ordenador:

1  Asegúrese de iniciar la sesión como 
administrador en la cuenta en la que se ha 
instalado Pro Tools. Para información sobre los 
privilegios de administrador en Mac OS X, 
consulte la documentación de Apple OS X. 

2  Inserte el CD-ROM de instalación de Pro Tools 
M-Powered o localice el archivo de instalación 
descargado. Haga doble clic en "Install Pro Tools 
M-Powered".

3  Introduzca la contraseña de administrador y 
haga clic en OK.

4  En la ventana del programa de instalación, 
elija la opción de desinstalación en el menú 
desplegable y haga clic en el botón para 
desinstalar. 

5  Para eliminar Pro Tools, siga las instrucciones 
en pantalla.

6  Cuando haya finalizado, haga clic en Quit 
para cerrar la ventana Installer.
Capítulo 3: Configuración para Macintosh 31



32
 Introducción a ProTools M-Powered



capítulo 4

Trabajo con Pro Tools M-Powered
En este aprendizaje de Pro Tools M-Powered se 
presentan las ventanas principales y funciones 
más importantes; asimismo, se explica paso a 
paso cómo grabar audio. 

Todas las funciones descritas en este capítulo se 
explican con detalle en la Guía de referencia de 
Pro Tools.

Puede acceder a una versión en PDF de la Guía de 
referencia en el menú de ayuda de Pro Tools. 

Información básica sobre 
sesiones
Los proyectos de Pro Tools M-Powered se crean 
y guardan como sesiones. En las sesiones se 
guardan todas las pistas, audio, MIDI y otro tipo 
de información de sesión. Los archivos de audio, 
de fundido, de grupo de regiones y de sesión de 
copia de seguridad se guardan en carpetas 
dentro de la carpeta Session.

Carpeta de sesión con el archivo de sesión y sus 
carpetas asociadas
Inicio de una sesión

Para crear una sesión:

1  Inicie Pro Tools M-Powered.

2  Elija File > New Session. 

3  En el cuadro de diálogo New Session, defina el 
tipo de archivo de audio, la frecuencia de 
muestreo y los parámetros de profundidad de 
bits para la nueva sesión.

4  Seleccione el lugar en el que desea guardar la 
sesión. Si usa discos duros externos con el 
sistema Pro Tools, asegúrese de seleccionar la 
unidad adecuada en el cuadro de diálogo New 
Session.

5  Escriba el nombre de la sesión.

6  Haga clic en Save. Se abren las ventanas Mix, 
Edit y Transport de la nueva sesión.

Cuadro de diálogo New Session
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Ventanas principales

Las ventanas Mix, Edit y Transport son las áreas 
de trabajo principales de Pro Tools. Para mostrar 
cualquiera de ellas, selecciónelas en el menú 
Window. 

Ventana Edit Muestra las pistas de la sesión a lo 
largo de la línea de tiempo, para la edición de 
audio, MIDI y datos de automatización. 
Introducción a ProTools M-Powered
Ventana Mix. Muestra el mezclador Pro Tools 
con los controles de tiras de canal para volumen, 
panorámico de audio, aislamiento, silenciamiento 
y dirección de señales. 

Para alternar entre las ventanas Edit y 
Mix, pulse Control + Igual (=) 
(Windows) o Comando + Igual (=) 
(Macintosh).
Figura 1.  Ventana Edit
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Ventana Transport Contiene controles para reproducción, detención, rebobinado, avance rápido, 
pausa y grabación. La ventana Transport también puede mostrar el contador y los controles MIDI.

Figura 2.  Ventana Mix
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Inserciones

Envíos

Controles de pista

Controles deslizantes de

Atenuador de volumen Medidor de nivel

Inserción de
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Figura 3.  Ventana Transport
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Reglas

Pro Tools M-Powered ofrece distintas reglas para 
facilitar la navegación por la sesión. 

Reglas de base de tiempo

Las reglas de base de tiempo que aparecen en la 
parte superior de la ventana Edit son Bars:Beats, 
Minutes:Seconds y Samples. La base de tiempo 
activa determina el formato del contador 
principal y es la base de la cuadrícula de la 
ventana Edit. 

Para seleccionar una regla de base de tiempo:

■ Haga clic en el nombre de la regla en la parte 
superior izquierda de la ventana Edit.

Reglas de director

Las reglas de director, justo debajo de las reglas 
de base de tiempo, incluyen Tempo, Meter y 
Markers. Las reglas Meter y Tempo indican 
cambios de compás y tempo, respectivamente, 
dentro de la sesión. Markers muestra 
marcadores asociados a ubicaciones de pista 
importantes. 

Selección de una regla de base de tiempo
Introducción a ProTools M-Powered
Configuración del tempo

El tempo de la sesión se puede establecer 
mediante el marcador de inicio de canción, 
ubicado en la regla Tempo.

Para definir el tempo de la sesión con el marcador 
de inicio de canción:

1  En la regla Tempo, haga doble clic en el 
marcador de inicio de canción.

2  En el cuadro de diálogo Tempo Change, 
especifique el valor de compases por minuto 
(bpm) que utilizará para la sesión. El evento de 
tempo insertado sustituye al tempo de sesión 
predeterminado.

3  Para que el valor de BPM se base en un valor de 
nota distinto (por ejemplo, corchea en lugar de 
cuarta, que es la predeterminada), en la sección 
Resolution seleccione un valor de nota.

4  Haga clic en OK.

Marcador de inicio de canción

Cuadro de diálogo Change Tempo

Marcador de inicio
de canción



Uso del módulo adicional Click

El módulo adicional Click genera un clic sonoro 
durante la reproducción de la sesión. 
Funciona como un metrónomo empleado 
como referencia de tempo para reproducir 
y grabar. 

El módulo adicional Click se sincroniza con el 
tempo y el compás de la sesión de Pro Tools, y 
tiene en cuenta los cambios que haya en ellos.

Parámetros de Click

Diodo de MIDI IN Se enciende cada vez que el 
módulo adicional Click recibe un mensaje de 
clic de la aplicación Pro Tools; de este modo se 
indica el tempo.

Accented Controla el nivel de salida del compás 
con acento (compás 1 de cada tiempo) del clic 
sonoro.

Unaccented Controla el nivel de salida de los 
compases sin acento del clic sonoro.

El módulo adicional Click es uno de los 
muchos que se pueden insertar en una pista 
de Pro Tools. Consulte "Módulos 
adicionales" en la página 59.

Módulo adicional Click
Para usar el módulo adicional Click:

1  Elija Options > Click para activar la opción 
Click.

– o –

Active el botón de clic (icono de metrónomo) en 
la ventana Transport.

2  Cree una pista de entrada auxiliar (Aux Input) 
mono.

3  Inserte un módulo adicional Click en la pista 
de entrada auxiliar. 

4  Elija un sonido de clic en el menú desplegable 
Librarian de la ventana del módulo adicional 
Click, (dicho menú muestra la opción "factory 
default" cuando se inserta el módulo adicional).

5  Elija Setup > Click y defina las opciones de 
Click y Countoff. 

6  Haga clic en OK.

Controles de clic de la ventana Transport

Selección de un sonido Click

Las opciones Note, Velocity, Duration y 
Output que aparecen en este cuadro de 
diálogo se utilizan con clics basados en 
instrumentos MIDI y no afectan al módulo 
adicional Click.

Botón de clic de metrónomo
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7  Comience la reproducción. Se genera un clic a 
partir del tempo y el compás de la sesión actual, 
así como de la configuración del cuadro de 
diálogo Click/Countoff Options.

Uso de la opción de clic con 
dispositivos MIDI externos

Pro Tools también permite utilizar un 
dispositivo MIDI externo para reproducir el clic. 
Esta función puede activarse o desactivarse en la 
ventana Transport; se configura en el cuadro de 
diálogo Click/Countoff. 

Para configurar y activar un clic MIDI externo:

1  Elija Setup > Click.

2  Configure los parámetros de clic necesarios 
para la fuente de sonido MIDI.

Cuadro de diálogo Click/Countoff Options

Consulte el apéndice A, "Configuración de 
MIDI Studio Setup (sólo Windows)" o el 
apéndice B, "Configuración de AMS (sólo en 
Mac OS X)" para obtener información sobre 
la configuración del estudio MIDI para su 
uso con Pro Tools.
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3  En el menú desplegable Output, seleccione 
una fuente de sonido MIDI y haya clic en OK.

4  Durante la grabación o reproducción, puede 
activar o desactivar el clic mediante el botón del 
metrónomo que se encuentra en los controles 
MIDI de la ventana Transport. 

Cómo guardar sesiones

Al construir una sesión añadiendo pistas, 
cambiando los parámetros de la sesión, etc., 
es necesario guardar el trabajo. En Pro Tools, 
las sesiones se pueden guardar de tres formas. 

Para guardar una sesión:

■ Elija File > Save, File > Save As, o File > Save 
Copy In.

Save  Guarda la sesión abierta y la deja abierta 
para continuar trabajando. 

Save As Crea un duplicado de la sesión abierta 
con el nombre que elija. Deja abierta la sesión 
duplicada para poder seguir trabajando. 
Puede ser útil si desea probar arreglos diferentes 
en la sesión sin que afecten a la sesión original.

Save Copy In Guarda una copia del archivo de 
sesión y permite guardar copias de todos los 
archivos de audio que se utilizan en la sesión. 
Puede ser útil para archivar una sesión, preparar 
una sesión para su transferencia a otro sistema, 
guardar en formatos de sesión de Pro Tools más 
antiguos o guardar una sesión con otra 
frecuencia de muestreo.

Controles de clic de la ventana Transport

Botón de clic de metrónomo



Recursos y configuración del 
sistema

Puede cambiar las opciones específicas de 
Pro Tools para optimizar el rendimiento del 
sistema.

Cuadro de diálogo Playback Engine

El cuadro de diálogo Playback Engine permite 
ajustar los distintos tamaños de búfer del 
sistema, así como asignar a Pro Tools capacidad 
de procesamiento de la CPU. 

Para configurar los recursos del sistema:

■ Elija Setup > Playback Engine. 

Para obtener información sobre cómo 
configurar el sistema, consulte el capítulo 
relativo a la configuración de la plataforma con 
que se ejecuta.

Ventana de utilización del sistema

La ventana de utilización del sistema muestra 
información aproximada sobre la carga de la 
CPU y el rendimiento general del disco. De este 
modo, el usuario puede evaluar la capacidad de 
procesamiento del sistema.

Cuadro de diálogo Playback Engine para Pro Tools 
M-Powered
Para ver los recursos y la utilización del sistema:

■ Elija Window > System Usage. 

Controles de transporte
La ventana Transport proporciona acceso a 
todos los comandos de transporte de Pro Tools. 
En esta ventana se pueden mostrar u ocultar 
diversos controles de transporte.

Para mostrar la ventana Transport:

■ Elija Window > Transport. 

Para configurar la ventana Transport:

■ Elija View > Transport y seleccione una opción 
de visualización. 

La ventana Transport contiene controles 
estándar de transporte para la reproducción, 
detención, etc.

Medidores de la ventana de utilización del sistema

Ventana Transport (en vista expandida)

Avance

Ir al final
Reproducir

Detener

Rebobinar

Vuelta a cero

Online
rápido

Activación
para

grabación
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La ventana Transport expandida muestra 
indicadores de pre-roll y post-roll, inicio, fin y 
duración de las selecciones de la línea de 
tiempo, así como el selector de transporte 
principal. 

La ventana Transport también muestra los 
controles MIDI siguientes: espera de nota, 
clic, descuento, fusión MIDI, director, medidor 
y tempo. 

Para iniciar y detener la reproducción:

1  En la ventana Transport, haga clic en el botón 
de reproducción para comenzar la 
reproducción.

2  En la ventana Transport, haga clic en el botón 
de detención para detener la reproducción.

Ventana Transport (controles MIDI)

Para iniciar y detener la reproducción, pulse 
la barra espaciadora del teclado.

Pro Tools comienza la reproducción desde la 
ubicación del puntero o desde el comienzo de 
la selección actual. La configuración actual 
del comando Link Edit and Timeline 
Selection en el menú Options también afecta 
a la reproducción. Para más información, 
consulte la Guía de referencia de Pro Tools.

Controles de

Activación de regla de Tempo

Fusión MIDI

Descuento

Clic de metrónomo

Espera
de nota

tempo y medidor
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Pistas
Pro Tools permite crear pistas de audio y 
grabación MIDI para submezclas, direcciones, 
automatización y edición.

Pro Tools permite trabajar con cinco tipos de 
pistas: pistas de audio, entradas auxiliares, 
atenuadores principales, pistas MIDI y pistas de 
instrumentos. Las pistas de audio, las entradas 
auxiliares, las pistas de instrumento y los 
atenuadores principales pueden ser mono o 
estéreo.

Pistas de audio Permiten grabar y reproducir 
audio a y del disco duro, supervisar la entrada de 
audio mientras se graba y editar regiones de 
audio.

Entradas auxiliares Canales de mezclador de 
audio usados para entradas, direcciones y 
submezclas.

Atenuadores principales Ofrecen controles y 
opciones de canal principal para cualquier salida 
o ruta de bus.

Pistas MIDI Permiten grabar, reproducir y editar 
datos MIDI.

Pistas de instrumentos Combine las funciones 
de las pistas de entrada auxiliar y MIDI, que 
permiten controlar y supervisar los módulos 
adicionales de instrumentos o los dispositivos 
MIDI externos en una sola tira de canal.

Para crear una pista:

1  Elija Track > New. 

Cuadro de diálogo New Track



2  Indique el número y tipo de pistas, y mono o 
estéreo (para todos los tipos salvo MIDI). 

Para crear varios tipos de pistas en un solo paso, 
en el cuadro de diálogo New Tracks haga clic en 
el botón "+". Especifique el número de pistas, 
tipo y formato en cada fila adicional de pistas 
que desee crear. 

3  Haga clic en Create.

En la ventana Mix, las pistas de audio, las 
entradas auxiliares, las pistas de instrumentos, 
los atenuadores principales y las pistas MIDI 
aparecen como tiras de canal verticales. 

El tipo de pista viene indicado por los iconos 
correspondientes que hay debajo de los 
atenuadores, así como por el color de las pistas.

Pistas en la ventana Mix

Pista de AtenuadorPista de

Pista de
entrada
auxiliar

instrumento

Pista MIDI

principalaudio
En la ventana Edit, las pistas se muestran en 
horizontal en la línea de tiempo. La zona en la 
que aparece el audio de cada pista es la lista de 
reproducción. 

Las pistas de audio, las entradas auxiliares, los 
atenuadores principales, las pistas MIDI y las 
pistas de instrumentos se pueden automatizar. 
Para más información, consulte 
"Automatización de mezcla" en la página 60. 

Pistas de audio

Las pistas de audio, las entradas auxiliares y los 
atenuadores principales comparten numerosos 
controles idénticos. La Figura 4 muestra los 
controles de las pistas de audio o de entrada 
auxiliar. Los atenuadores principales tienen las 
mismas funciones que las pistas de audio y las 
entradas auxiliares, con algunas excepciones: 

Selector de entrada La asignación de salida de 
un atenuador principal determina su entrada o 
fuente. 

Inserciones Las inserciones en los atenuadores 
principales son sólo post-atenuador. 
(Las inserciones en la pista de audio y la entrada 
auxiliar son pre-atenuador.)

Reglas de línea de tiempo y una pista de audio en la 
ventana Edit

Timeline

Lista de reproducción
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Envíos Los atenuadores principales no efectúan 
envíos. Utilice una entrada auxiliar si desea 
enviar una salida a otro destino.

Figura 4.  Pista de audio estéreo en la ventana Mix
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Pistas MIDI

Las pistas MIDI ofrecen volumen, aislamiento y 
silenciamiento, además de controles de entrada 
MIDI, salida, canal y programa (parche). 
La Figura 5 muestra los controles de las pistas 
MIDI. 

Figura 5.  Pista MIDI en la ventana Mix
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Pistas de instrumentos

Las pistas de instrumentos tienen múltiples 
controles en común con las pistas de audio, 
además de tener una vista de instrumentos 
adicional, que ofrece controles para entrada, 
salida, silenciamiento, volumen y panorámico 
MIDI. La Figura 6 muestra los controles de las 
pistas de instrumentos. 

Figura 6.  Pista de instrumento estéreo en la 
ventana Mix
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Lista de regiones
Una región es un fragmento de información audio 
o MIDI que puede tener datos de auto-matización 
asociados. Por ejemplo, una región puede ser un 
bucle, una melodía de guitarra, un verso de una 
canción, un efecto de sonido, un fragmento de 
diálogo o todo un archivo de sonido. 

En Pro Tools, las regiones se crean a partir de 
archivos de audio o MIDI, y se pueden organizar 
en listas de reproducción de pistas de audio, MIDI 
e instrumentos.

Todas las regiones grabadas, importadas o creadas 
mediante edición aparecen en la lista de regiones. 
Es posible arrastrar regiones desde la lista hasta 
pistas y organizarlas como se desee. También se 
pueden oír las regiones de audio desde la lista de 
regiones, pulsando Alt (Windows) u Opción 
(Macintosh) mientras se hace clic en el nombre de 
la región. El menú emergente de lista de regiones 
brinda funciones útiles para gestionar archivos y 
regiones. Entre otras, de clasificación, selección o 
importación y exportación de archivos.

Lista de regiones

Para más información sobre la lista de 
regiones, consulte la Guía de referencia de 
Pro Tools.

Arrastrar el borde para 
modificar la anchura de 
la lista de regiones

Hacer clic en el botón de 
las regiones para abrir el 
menú desplegable

Hacer clic para ocultar la lista de regiones
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Navegación en una sesión
Pro Tools ofrece varias maneras de navegar en 
una sesión; por ejemplo, mediante el ratón o 
introduciendo una ubicación de memoria en 
uno de los contadores.

Para navegar hasta una ubicación en la ventana 
Edit:

1  En el menú Options, compruebe que la 
opción Link Timeline and Edit Selection esté 
activada.

2  Active la herramienta de selección en la parte 
superior de la ventana Edit haciendo clic en ella.

3  Haga clic en una pista o una regla de base de 
tiempo. El cursor se coloca en el punto 
seleccionado; los contadores muestran la 
posición actual de tiempo.

Para navegar usando los contadores:

1  Haga clic en el contador principal e introduzca 
una ubicación con el teclado. 

2  Pulse Intro (Windows) o Retorno (Macintosh). 

Herramientas de edición de la ventana Edit

Hacer clic en la ventana Edit con la herramienta de 
selección

Herramienta de selección

Hacer clic en una pista o en una regla de base de tiempo
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Ubicaciones de memoria

Las ubicaciones de memoria y los marcadores 
constituyen otra forma de navegar por las 
sesiones. Las ubicaciones de memoria aparecen 
como marcadores debajo de las reglas de base de 
tiempo. Puede guardar hasta 999 ubicaciones de 
memoria o marcadores en una sesión.

Para definir una ubicación de memoria:

1  Vaya a la ubicación en la que desee establecer 
un marcador o una ubicación de memoria.

– o –

Empiece a reproducir en cualquier punto 
anterior a la ubicación en la que desea guardar 
un marcador o una ubicación de memoria. 

2  Cree una ubicación de memoria mediante una 
de las alternativas siguientes:

• Pulse la tecla Intro del teclado numérico.

– o –

• Haga clic en el botón Add Marker/Memory 
Location ("+"), situado a la izquierda de la 
regla Markers. 

Navegación con el contador

Pulse la tecla asterisco (*) en el teclado 
numérico en lugar de hacer clic en el 
contador. (El cursor siempre aparece en el 
contador principal de la ventana Transport 
si está abierta.) 

En algunos portátiles con Windows, la 
ubicación de memoria se crea pulsado una 
tecla de función e Intro. Es una opción muy 
útil en los portátiles que carecen de teclado 
numérico.



En el cuadro de diálogo New Memory Location, 
puede definir un marcador, guardar una 
selección o una combinación de otras opciones 
disponibles. Entre ellas está la altura de pista, 
activaciones de grupos, valores de pre-roll y 
post-roll, y estados de mostrar/ocultar pistas. 

3  Elija la configuración de la ubicación de 
memoria y haga clic en OK.

Para ir a una ubicación de memoria guardada: 

1  Elija Window > Memory Locations.

2  En la ventana Memory Locations, haga clic en 
el nombre de la ubicación de memoria.

Cuadro de diálogo New Memory Location

Ventana de ubicaciones de memoria
Visualización y zoom

Al ver pistas en la ventana Edit, puede ajustar su 
altura, así como ampliarlas en vertical y 
horizontal usando el selector de altura de pista y 
las herramientas de zoom.

Para cambiar la altura de una pista:

■ Haga clic en el selector de altura de pista 
(la barra vertical escalada a la izquierda de la 
pista) y seleccione una altura de pista en el 
menú emergente.

Herramientas de zoom y altura de pista de la 
ventana Edit

Puede aplicar varios comandos, entre los 
que se incluye la selección de la altura de 
pista, a más de una pista. Mantenga 
pulsada la tecla Alt (Windows) u Opción 
(Macintosh) mientras efectúa una operación 
para aplicarla a todas las pistas. Mantenga 
pulsadas las teclas Mayús y Alt (Windows) 
o Mayús y Opción (Macintosh) mientras 
efectúa una operación para aplicarla a todas 
las pistas seleccionadas.

Botones
Herramienta

Botones Zoom In/Out

Selector de altura de pista

Botón de

de zoom
predefinidos de zoom

alternancia
de zoom
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Para acercar o alejar cualquier zona de una pista 
en la ventana Edit:

1  Haga clic en la herramienta de zoom para 
seleccionarla.

2  Haga clic o arrastre el ratón con la 
herramienta de zoom para ampliar 
horizontalmente una pista o regla. 

– o –

Pulse la tecla Alt (Windows) u Opción 
(Macintosh) y haga clic con la herramienta 
de zoom para reducir horizontalmente una 
pista o regla.

Para ampliar o reducir por incrementos:

■ Haga clic en el botón de zoom 
correspondiente:

• Botón de alejar (flecha izquierda)

• Botón de acercar (flecha derecha)

• Botones de audio o zoom MIDI, para 
aumentar o disminuir el zoom vertical del 
tipo de pista correspondiente

Para ampliar o reducir continuamente:

1  Seleccione la herramienta de zoom. 

2  Mantenga pulsada la tecla Inicio (Windows) o 
Control (Macintosh) y arrastre una pista del 
modo siguiente:

• Arrastre hacia arriba para acercar 
verticalmente

• Arrastre hacia abajo alejar verticalmente

• Arrastre a la derecha para acercar 
horizontalmente

• Arrastre a la izquierda para alejar 
horizontalmente
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Alternancia de zoom

El botón de alternancia de zoom permite 
guardar un estado de zoom y alternarlo con el 
estado de zoom actual. Cuando está activada la 
opción de alternancia de zoom, la ventana Edit 
muestra el estado de zoom guardado. Si está 
desactivada, la ventana Edit vuelve al último 
estado de zoom.

Para guardar un estado de zoom con el botón de 
alternancia:

1  Realice una selección de edición.

2  Haga clic en el botón de alternancia de zoom 
para resaltarlo.

3  Ajuste la altura de pista, el zoom vertical, 
la vista de pista y la cuadrícula.

4  Realice las ediciones necesarias.

5  Haga clic en el botón de alternancia de zoom 
encendido para volver al último estado de 
zoom. 

6  Realice otra selección de edición y haga clic en 
el botón de alternancia de zoom para 
seleccionar el estado de zoom guardado y seguir 
editando.

Zoom predeterminado

Pro Tools consta de cinco botones de zoom 
predeterminados. Puede utilizarlos para 
restablecer de inmediato los niveles de zoom 
establecidos. Es posible definir el nivel de zoom 
para cada botón predeterminado en cada sesión.

Botón de alternancia de zoom en la barra de 
herramientas

Botón de alternancia de zoom



Para guardar una definición de zoom 
predeterminado:

1  Utilice la herramienta Zoom para establecer 
un valor de zoom.

2  Haga clic en un botón de zoom 
predeterminado (1–5) y elija Save Zoom Preset 
en el menú emergente Zoom Preset. 

Para utilizar un valor de zoom predeterminado 
guardado:

■ Haga clic en un botón de zoom 
predeterminado (1–5).

Uso de las ubicaciones de memoria 
para el control de zoom

Las ubicaciones de memoria de Pro Tools 
permiten guardar muchos atributos con cada 
marcador o ubicación de memoria, incluidos la 
altura de pista y la configuración de zoom. 
Las ubicaciones de memoria creadas, que no son 
marcadores ni selecciones pero tienen altura de 
pista, configuración de zoom u otras opciones, 
podrán usarse para acercar y alejar mediante el 
uso exclusivo del teclado numérico.

Para más información sobre creación de 
ubicaciones de memoria, consulte "Ubicaciones 
de memoria" en la página 44.

Menú emergente Zoom Preset
Importación de datos en 
sesiones de Pro Tools
Pro Tools permite importar audio, MIDI y una 
gran variedad de datos de sesión de Pro Tools en 
la sesión actual. 

Importación de audio

Con Pro Tools puede importar archivos de audio 
del disco duro o de un CD. Resulta muy útil si ya 
tiene grabados en disco archivos de audio o si 
trabaja con bibliotecas de muestras en CD-ROM 
que desea utilizar en una sesión.

Para importar archivos de audio o regiones desde 
el disco:

■ Elija File > Import > Audio to Track para 
importar archivos y regiones a nuevas pistas de 
audio (aparecerán también como regiones en la 
lista de regiones). 

– o –

■ Elija File > Import > Audio to Region List para 
importar archivos y regiones sólo a la lista de 
regiones.

Para importar una pista de audio de un CD:

1  Coloque el CD en la unidad de CD del 
ordenador.

2  Seleccione Window > Workspace y haga clic 
en el icono de CD de audio para ver los archivos 
del CD.
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3  Haga clic en el icono de altavoz en la columna 
Waveform del navegador del espacio de trabajo 
para oír el archivo correspondiente. Pulse la 
barra espaciadora para detener la reproducción.

4  Lleve a cabo uno de estos procedimientos:

■ Arrastre archivos de audio del navegador de 
espacio de trabajo a la lista de pistas de la 
ventana Edit para importar los archivos a pistas 
de audio nuevas (también aparecerán como 
regiones en la lista de regiones).

– o –

■ Arrastre archivos de audio del navegador de 
espacio de trabajo a la lista de regiones de la 
ventana Edit para importar los archivos sólo a la 
lista de regiones.

Audición de un archivo de audio en el navegador de 
espacio de trabajo

Acción de arrastrar el archivo de audio del 
navegador de espacio de trabajo a la lista de pistas 
de la ventana Edit
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Importación de MIDI

Pro Tools permite importar archivos MIDI a la 
lista de regiones o directamente en las pistas 
MIDI de una sesión. 

Para importar archivos MIDI a la lista de regiones:

■ Elija File > Import > MIDI a la lista de regiones.

Para importar archivos MIDI a las pistas:

1  Elija Window > Workspace y localice los 
archivos MIDI que desee importar.

2  Arrastre los archivos MIDI del navegador de 
espacio de trabajo a la lista de pistas.

3  En el cuadro de diálogo Import MIDI Settings, 
elija la ubicación de importación y las opciones 
para el audio MIDI que está importando.

Para obtener más información sobre cómo 
buscar, oír e importar audio con DigiBase, 
consulte la Guía de DigiBase.

Acción de arrastrar un archivo MIDI del navegador de 
espacio de trabajo a la lista de pistas de la ventana Edit

Cuadro de diálogo Import MIDI Settings



Importación de archivos desde el 
Explorador de Windows y Finder 
de Macintosh

Pro Tools permite arrastrar y soltar archivos de 
audio, MIDI, de grupo de regiones, REX y ACID 
directamente desde el Explorador de Windows o 
Finder de Macintosh en la línea de tiempo o la 
lista de regiones de una sesión de Pro Tools. 

Grabación básica
En esta sección se describe cómo grabar audio y 
MIDI en Pro Tools. 

Preparación para grabar

Para preparar una pista de audio para grabación:

1  Verifique las conexiones a los micrófonos o 
instrumentos.

2  Elija Track > New. Especifique 1 Mono Audio 
Track o Stereo Audio Track (según la fuente de 
sonido) y haga clic en Create.

3  En la ventana Mix, haga clic en el selector de 
ruta de entrada de audio de la nueva pista. 

Para obtener más información acerca de la 
importación de datos en sesiones de 
Pro Tools, consulte la Guía de referencia de 
Pro Tools.

Para más información sobre cómo conectar 
instrumentos, consulte la documentación 
que se proporciona con la interfaz de 
M-Audio.
4  En el menú emergente, seleccione la entrada 
de interfaz que desee grabar. Por ejemplo, 
seleccione Mic/Line 1 si la fuente de audio está 
enchufada en la entrada 1 de la interfaz de 
M-Audio.

Configuración de los niveles de 
entrada

Utilice los controles de ganancia de la interfaz 
de M-Audio (si los hay) para maximizar la señal 
que se envía a Pro Tools sin que se produzca 
clipping. Los niveles de señal de la entrada 
también se pueden ajustar en la fuente.

Cuando entra una señal en Pro Tools, asegúrese 
de ajustar el nivel de entrada para optimizar el 
rango dinámico y la relación señal-ruido del 
archivo grabado. Si el nivel de entrada es 
demasiado bajo, no podrá aprovechar al 
máximo el rango dinámico del sistema 
Pro Tools. Si el nivel de entrada es demasiado 
elevado, se producirá clipping en la forma de 
onda y se distorsionará la grabación.

Selección de una entrada en la ventana Mix

Dirección de una entrada a una pista estéreo

Selector de ruta de
entrada de audio
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Intente definir los niveles para que se registren 
dentro del máximo de 6 dB del medidor de 
entrada sin activar el indicador de clipping en la 
interfaz de audio.

Grabación de una pista de audio

Para grabar una pista de audio:

1  Asigne la entrada para una pista y ajuste los 
niveles de entrada.

2  Haga clic en el botón de activación para 
grabación de una pista. 

3  Para ver la ventana Transport, elija Window > 
Transport.

Configure los niveles de entrada para evitar 
el clipping. Ajuste el control de ganancia en 
un nivel en el que los diodos de cresta de la 
parte frontal de una interfaz de M-Audio no 
parpadeen.

Activación de una pista para grabar en la ventana Mix

Ventana Transport (en vista expandida)

Avance

Ir al final
Reproducir

Detener

Rebobinar

Vuelta a cero

Online
rápido

Activación
para

grabación
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4  Haga clic en el botón de vuelta a cero para 
comenzar a grabar desde el principio de la 
sesión. También puede grabar según una 
selección o desde la ubicación del cursor en la 
ventana Edit. 

5  Haga clic en el botón de grabación en la 
ventana Transport para activar la grabación.

6  Haga clic en el botón de reproducción o pulse 
la barra espaciadora para grabar en todas las 
pistas activadas para la grabación.

7  Grabe su interpretación.

8  Cuando la grabación haya concluido, haga 
clic en el botón de detención en la ventana 
Transport o pulse la barra espaciadora.

Para reproducir una pista grabada:

1  Haga clic de nuevo en el botón de grabación 
de la pista para salir del modo de grabación. 

2  Para comenzar la reproducción, haga clic en el 
botón de reproducción en la ventana Transport 
o pulse la barra espaciadora.

3  Para detener la reproducción, haga clic en el 
botón de detención en la ventana Transport o 
pulse la barra espaciadora.

Grabación MIDI

Las pistas de instrumentos combinan una pista 
MIDI y una entrada auxiliar en una sola tira de 
canal que proporciona funciones tanto de audio 
como de MIDI. Las pistas de instrumentos 
permiten grabar MIDI y supervisar el audio 
desde instrumentos de software y hardware.

Para crear una pista de instrumento y configurarla 
para la grabación:

1  Elija Setup > MIDI > Input Devices y 
compruebe que el dispositivo de entrada esté 
seleccionado en la ventana MIDI Input Enable; 
luego haga clic en OK.



2  Elija Track > New; especifique 1 Mono 
Instrument Track y haga clic en Create.

3  Seleccione View > Mix Window > Instruments 
para ver los controles MIDI en la parte superior 
de la pista de instrumento de la ventana Mix.

4  Haga clic en el selector de entrada MIDI de la 
pista y asigne el dispositivo y el canal que van a 
grabarse, o déjelo configurado en All.

5  Lleve a cabo una de las acciones siguientes, 
según el tipo de instrumento que esté 
utilizando:

• Si está utilizando un módulo adicional de 
instrumento, haga clic en un selector de 
inserción e inserte el módulo adicional en 
la pista de instrumento. La salida MIDI de 
la pista se asigna automáticamente al 
módulo adicional del instrumento.

Selector de entrada MIDI en una pista de instrumento

Inserción de un módulo adicional de instrumento en 
una pista de instrumento

Selector de entrada MIDI
• Si está utilizando un dispositivo MIDI 
externo, haga clic en el selector de salida 
MIDI de la pista (en la parte superior de la 
pista de instrumento), y asígnelo a un canal 
y un dispositivo para recibir la salida MIDI 
(las opciones varían según el dispositivo).

6  Puede asignar un cambio de programa 
predeterminado a la pista: haga clic en el botón 
de selección de parche en la ventana Mix, 
realice las pertinentes selecciones de programa y 
banco y, a continuación, haga clic en Done. 
Las modificaciones de programa 
predeterminadas se envían cuando se 
reproduce la pista.

Selector de salida MIDI en una pista de instrumento

Si no aparece el dispositivo MIDI que está 
conectado, compruebe que el ordenador y sus 
parámetros de MIDI estén configurados. 
Para más información, consulte el 
apéndice A, "Configuración de MIDI Studio 
Setup (sólo Windows)" o el apéndice B, 
"Configuración de AMS (sólo en Mac OS X)".

Botón de selección de parche en una pista de 
instrumento

Botón de selección de parche
Capítulo 4: Trabajo con Pro Tools M-Powered 51



52
7  Si está utilizando un dispositivo MIDI externo 
y conecta la salida de audio a una interfaz de 
audio para supervisar en Pro Tools, haga clic en 
el selector de entrada de audio de la pista de 
instrumento y elija la entrada de audio 
correspondiente.

8  Haga clic en el botón de activación para 
grabación de pista para activar la pista de 
instrumento para la grabación MIDI.

9  Asegúrese de que Options > MIDI Thru esté 
seleccionado.

10  Reproduzca algunas notas en el controlador 
MIDI y busque el medidor de velocidad MIDI de 
la pista para mover. Recuerde que MIDI no es 
audio y que el medidor de MIDI no registra 
sonido, sino actividad MIDI.

11  Ajuste el nivel de salida de audio de la pista 
de instrumento con su atenuador de volumen.

Selección de entrada de audio para una pista de 
instrumento

Medidor de MIDI en pista de instrumento que muestra 
actividad MIDI

Medidor de velocidad MIDI
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Para registrar MIDI en la pista de instrumento:

1  Compruebe que la pista de instrumento en la 
que desea grabar esté activada para grabación y 
que reciba MIDI.

2  En la ventana Transport, haga clic en el botón 
de vuelta a cero para iniciar la grabación desde el 
principio de la sesión. También puede grabar en 
una selección en la pista o desde la ubicación del 
puntero en la ventana Edit.

3  Haga clic en el botón de grabación en la 
ventana Transport.

4  Lleve a cabo uno de estos procedimientos: 

• Para comenzar la grabación, haga clic en el 
botón de reproducción de la ventana 
Transport o pulse la barra espaciadora.

• Si utiliza espera de nota, parpadean los 
botones de reproducción, grabación y 
espera de nota. La grabación comienza 
cuando se empieza a recibir 
información MIDI.

• Si usa descuento, haga clic en el botón de 
reproducción. Los botones de grabación y 
reproducción parpadean durante el 
descuento, tras lo cual comienza la 
grabación.

5  Reproduzca el controlador MIDI o dispositivo 
de entrada.

6  Cuando haya terminado de grabar, haga clic 
en el botón de detención en la ventana 
Transport o pulse la barra espaciadora. 
La información MIDI grabada aparece como 
una región MIDI en la pista en la ventana Edit y 
en la lista de regiones.

Datos MIDI en la pista de instrumento



Para reproducir los datos MIDI grabados:

1  Para desactivar el modo de grabación de la 
pista de instrumento, haga clic en el botón de 
grabación.

2  En la ventana Transport, haga clic en el botón 
de vuelta a cero para reproducir desde el 
principio de la pista.

3  En la ventana Transport, haga clic en el botón 
de reproducción para comenzar la 
reproducción. La información MIDI grabada se 
reproduce a través del instrumento y canal 
asignados a la pista.

Edición
Pro Tools ofrece distintas herramientas para 
edición de audio y pistas MIDI. En la ventana 
Edit, las pistas de audio y MIDI se pueden editar 
en regiones o repetir en diferentes ubicaciones 
para crear bucles, reorganizar secciones o 
canciones completas, o para montar pistas con 
el material procedente de varias tomas. 

La edición de audio y MIDI se usa para lo 
siguiente:

• Reparar o sustituir errores.

• Hacer arreglos a canciones y proyectos.

• Limpiar la temporización y el ritmo de la 
pista alineando los golpes a valores de 
cuadrícula como barras y compases.

• Crear pistas finales con selecciones de 
varias tomas (también se denominan pistas 
de compilación).

Herramientas y modos de edición

Modos de edición Herramientas de edición
Modos de edición

Pro Tools tiene los siguientes modos de edición: 
Shuffle, Spot, Slip y dos modos de Grid, Absolute 
(modo estándar de cuadrícula de Pro Tools) 
y Relative.

El modo de edición se selecciona haciendo clic 
en el botón correspondiente en la parte superior 
izquierda de la ventana Edit.

El modo de edición determina el movimiento y 
la colocación de regiones de audio y MIDI 
(y notas MIDI individuales), el funcionamiento 
de comandos como Copy y Paste, y el de 
diversas herramientas (de recorte, selección, 
mano y líneas).

Herramientas de edición

Pro Tools tiene siete herramientas de edición: 
zoom, recorte, selección, en forma de mano, 
búsqueda de audio, líneas e inteligente. 
Seleccione una de estas herramientas haciendo 
clic en el botón correspondiente en la ventana 
Edit. Las herramientas de zoom, recorte, 
en forma de mano y de líneas tienen varios 
modos, que se pueden seleccionar en un menú 
emergente al hacer clic en la herramienta.

Botones de modos de edición

Para establecer el modo de edición, pulse F1 
(Shuffle), F2 (Slip), F3 (Spot) o F4 (Grid).

Para una descripción más detallada de los 
modos de edición, consulte la Guía de 
referencia de Pro Tools.
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Listas de reproducción y edición no 
destructiva

Las listas de reproducción permiten crear y 
recuperar varias versiones de ediciones de pista. 
Una lista de reproducción puede ser una toma 
completa, un doblaje o una serie de selecciones 
de varias tomas. Puede duplicar listas de 
reproducción para guardar ediciones en su 
estado actual y seguir editando en la lista de 
reproducción nueva sabiendo que siempre 
puede volver a la versión anterior. 

Herramientas de edición de la ventana Edit

Pulse la tecla Esc para alternar entre las 
herramientas de edición.

Para más información sobre las 
herramientas de edición, consulte la Guía 
de referencia de Pro Tools.

Herramienta Herramienta en

Herramienta

HerramientaHerramientaHerramienta

Herramienta

de recorte forma de mano

de selección de búsqueda de audio

de zoom inteligente de líneas
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Para crear varias listas de reproducción 
para editar:

1  Empiece con una pista en la que desea probar 
diferentes clases de ediciones.

2  Haga clic en el selector de lista de 
reproducción de la pista y elija la opción 
Duplicate en el menú emergente.

3  Asigne un nombre a la lista de reproducción 
duplicada y haga clic en OK.

4  Haga las primeras ediciones.

5  Haga clic en el selector de lista de 
reproducción en el menú desplegable y elija la 
lista de reproducción original para volver a él.

6  Repita los pasos 2–5 con diferentes tipos de 
ediciones.

De este modo, puede probar distintas ediciones 
en una pista y alternar entre las listas de 
reproducción para compararlas.

Edición de regiones

Las herramientas de edición de Pro Tools se 
utilizan para editar regiones en la ventana Edit. 

Selector de lista de reproducción

Región de audio

Selector de lista
de reproducción



Recorte de regiones

Tras haber grabado una pista de audio, en ella 
dispondrá de una región de audio. Si al 
comienzo de la región hay un espacio en blanco 
o si al final hay un espacio de audio vacío, el 
principio y el final de la región se pueden acortar 
con la herramienta de recorte en modo Slip.

Para recortar una región de audio:

1  Seleccione el modo Slip.

2  Seleccione la herramienta de recorte.

3  Desplace el cursor cerca del comienzo de la 
región de audio (observe que el cursor se 
muestra en forma de "[").

4  Haga clic en el comienzo de la región y 
arrastre hacia la derecha para acortar la región.

5  Desplace el cursor cerca del final de la región 
de audio (observe que el cursor se muestra en 
forma de "]").

Región de audio en una pista

Recorte del comienzo de una región

Recorte del final de una región
6  Haga clic en el final de la región y arrastre 
hacia la izquierda para acortar la región.

También puede extender una región mediante 
la herramienta de recorte si existen datos de 
audio fuera de los límites de la región. 
Para extender el comienzo de la región, 
arrastre hacia la izquierda; si se trata del final, 
hágalo hacia la derecha.

Organización de regiones

Hay varias maneras de editar y organizar 
regiones; el ejemplo siguiente muestra cómo 
crear y organizar un bucle de batería para 
componer una pista de ritmo.

Para crear y organizar una secuencia de ritmo:

1  Abra o cree una sesión en Pro Tools. 

2  En la ventana Edit, defina el compás y el 
tempo de la sesión del siguiente modo:

• Haga clic en el selector de vista de regla y 
elija Tempo y Meter.

• Haga clic en el botón Add Tempo Change y 
especifique el tempo.

• Haga clic en el botón Add Meter Change y 
especifique el compás.

La región recortada

Botones Add Tempo Change y Add Meter Change

Add Tempo Change
Add Meter Change
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3  Haga clic en el botón de modo Grid para 
activar el modo Grid en Pro Tools.

4  Prepare la grabación con un clic MIDI 
(consulte "Uso del módulo adicional Click" en la 
página 37 o "Uso de la opción de clic con 
dispositivos MIDI externos" en la página 38). 

5  Grabe una pista de batería (consulte 
"Grabación de una pista de audio" en la 
página 50); no olvide que conviene usar la 
mejor barra (compás). La grabación debería 
ajustarse a la cuadrícula en el tempo y medidor 
especificados.

– o –

Importe un archivo de audio, por ejemplo un 
bucle de batería de una biblioteca de muestras, 
y colóquelo en una pista de audio (consulte 
"Importación de audio" en la página 47).

6  Haga clic en la herramienta de selección y 
arrastre la forma de onda para hacer una 
selección de un compás. La selección se alinea 
con la cuadrícula especificada.

7  Elija Track > New y cree una pista de audio 
estéreo. 

8  Haga clic en la herramienta en forma de mano 
y seleccione la herramienta Separation.

9  Con la herramienta Separation, arrastre la 
selección al comienzo de la nueva pista de 
audio. Se crea una región y aparece al principio 
de la nueva pista.

Cómo efectuar una selección en modo Grid
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10  Con la región nueva aún seleccionada, 
elija Region > Loop.

11  En el cuadro de diálogo Region Looping, 
especifique el número de bucles que desea crear 
para la región y haga clic en OK.

Ahora tiene una pista de ritmo nueva con una 
frase "en bucle" (repetida). 

Beat Detective y estas herramientas de edición se 
pueden utilizar para editar regiones de forma 
mucho más compleja.

Agrupación de regiones

La función Region Groups de Pro Tools permite 
agrupar regiones en varias pistas de audio 
adyacentes, MIDI y de instrumento. Los grupos 
de regiones son útiles para manipular, editar y 
organizar el estilo y el tempo.

Cómo arrastrar una selección con la herramienta 
Separation

Cuadro de diálogo Region Looping

Para más información sobre los grupos de 
regiones, consulte la Guía de referencia de 
Pro Tools.



Mezclas
El entorno de mezcla de Pro Tools consta de 
muchos controles de tira de canal conocidos 
para configurar el volumen, el panorámico de 
audio, el aislamiento y el silenciamiento. 
Los controles de mezclador y E/S pueden 
mostrarse en las ventanas Mix y Edit.

Para ver la ventana Mix:

■ Seleccione Window > Mix.

Uso de controles de tira de canal de audio

Los siguientes controles son comunes a las pistas 
de audio, entrada auxiliar e instrumento.

Atenuador de volumen Aumente o disminuya el 
nivel de la pista arrastrando el atenuador de 
volumen arriba o abajo.

Control deslizante de panorámico de audio 
Efectúe un panorámico de audio de pista a la 
izquierda o derecha en la mezcla arrastrando el 
control deslizante de panorámico de audio a la 
izquierda o la derecha.

Botón Solo Aísle una pista (silenciando todas las 
demás) haciendo clic en el botón de aislamiento 
(Solo).

Botón Mute Silencie una pista haciendo clic en 
el botón Mute.

Para alternar entre las ventanas Edit y Mix, 
pulse las teclas Control + Igual (=) en 
Windows o Comando + Igual (=) en 
Macintosh.
Dirección de señales básica

La dirección de señales se logra mediante la 
asignación de entradas y salidas de pistas. 
Las entradas de pista de audio pueden ser de 
cualquier entrada de hardware o ruta de bus. 
Una vez grabada, la entrada de una pista de 
audio es su archivo de audio en el disco. 
Las entradas auxiliares pueden ser cualquier 
entrada de hardware o ruta de bus interna. 
En todos los tipos de pistas de audio, las salidas 
se pueden dirigir a cualquier salida de hardware 
o ruta de bus interna.

Estas funciones de dirección de señal permiten 
configurar prácticamente cualquier arquitectura 
de mezclador necesaria para los proyectos, 
incluidos envíos y retornos para procesamiento 
de efectos y submezclas.

Submezclas de envío y retorno para 
procesamiento de efectos

Cuando cree submezclas para realizar 
procesamientos de efectos como reverberación o 
retardo, use envíos y entradas auxiliares para 
conseguir buses de envío/retorno. Puede usar un 
módulo adicional en tiempo real (consulte 
"Módulos adicionales" en la página 59) como 
recurso compartido para todas las pistas que se 
incluyen en una submezcla. El equilibrio 
wet/dry de la mezcla se puede controlar 
mediante los atenuadores de pista (nivel dry) y 
el atenuador de entrada auxiliar (retorno de 
efecto o nivel wet).

Creación de un envío

Pro Tools proporciona hasta diez envíos por 
pista de audio. Un envío puede ser mono o 
estéreo, dirigido a una salida o a una de las 
32 rutas de bus internas. 
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Para asignar un envío en una pista:

1  Asegúrese de que los envíos que desee usar 
estén visibles en la ventana Mix (View > 
Mix Window > Sends A–E o Sends F–J). 

2  En la ventana Mix, haga clic en un selector de 
envío de una pista de audio y elija una ruta en el 
menú emergente.

3  Establezca el nivel de salida del envío. 
Puede establecer el nivel de envío en cero 
pulsando la tecla Alt (Windows) u Opción 
(Macintosh) y haciendo clic en el atenuador 
de envío. 

Asignación de un envío a una ruta de bus estéreo

Puede configurar el nivel predeterminado 
de los nuevos envíos en –∞ o en una 
ganancia de unidad (0 dB) activando o 
desactivando la opción Sends Default To 
"–INF" en la ficha Operation de 
Preferences. 
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Creación de un retorno

Las pistas de entrada auxiliar pueden crearse 
para actuar como canales de retorno para buses, 
así como entradas de fuentes de hardware.

Para crear un retorno:

1  Elija Track > New y especifique 1 Mono o 
Stereo Auxiliary Input; a continuación, haga clic 
en Create.

2  Haga clic en el selector de entrada de la 
entrada auxiliar y establézcala en la ruta de bus 
asignada a los envíos en las pistas de origen.

3  Haga clic en el selector de salida de la entrada 
auxiliar y elija una ruta de salida.

Pistas de audio y entrada auxiliar configuradas para un 
envío y un retorno

Ventana Envío a bus 1-2

Módulo adicional en tiempo real

Entrada

Pista de entrada auxiliar 

Pistas de audio

de pista
auxiliar de
bus 1-2 

de envío



Atenuadores principales

Los atenuadores principales se usan como salida 
y bus principal. Pueden controlar cualquier 
salida mono, estéreo o ruta de bus de una sesión. 
Así, los controles del atenuador principal 
pueden usarse para controlar el volumen, 
el aislamiento y el silenciamiento, o para aplicar 
inserciones a esas rutas. 

Para crear un atenuador principal:

1  Elija Track > New y especifique 1 Mono o 
Stereo Master Fader; a continuación, haga clic 
en Create.

2  En la ventana Mix, haga clic en el selector de 
salida de atenuador principal y elija la ruta de 
salida que desee controlar. Puede elegir entre 
salidas o buses internos.

Atenuador principal que controla la ruta de salida 
principal

Salida asignada para
controlar la mezcla principal
Para usar un atenuador principal como control de 
volumen principal para todas las pistas de una 
sesión:

1  Elija Track > New y especifique 1 Stereo Master 
Fader; a continuación, haga clic en Create.

2  Establezca las salidas de todas las pistas de 
audio de la sesión en las salidas 1–2 y el 
panorámico de audio de cada pista.

3  Establezca la salida del atenuador principal en 
la ruta de salida principal (salidas 1–2).

Módulos adicionales
Los módulos adicionales permiten procesar 
efectos de ecualización, dinámicos, de retrasos, 
etcétera. Además, funcionan en tiempo real 
(RTAS) o no real (AudioSuite).

Los módulos adicionales RTAS son efectos no 
destructivos, que se introducen en las pistas para 
procesar audio en tiempo real, durante la 
grabación, como un procesador externo de 
hardware. 

Los módulos adicionales AudioSuite se emplean 
para procesar y modificar archivos de audio en 
disco, más que de forma no destructiva en 
tiempo real. Dependiendo de cómo se configure 
un módulo adicional AudioSuite en tiempo no 
real, se puede crear un archivo de audio 
completamente nuevo o alterar el archivo de 
audio fuente original.
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Los módulos adicionales en tiempo real se 
asignan a pistas de la vista de inserciones en las 
ventanas Mix o Edit. Una vez asignados a una 
pista, los módulos adicionales aparecen en la 
vista de inserciones de la pista y pueden abrirse 
haciendo clic en el botón de inserción.

Para insertar un módulo adicional en tiempo real 
en una pista:

1  La vista de inserciones se debe mostrar en la 
ventana Mix o Edit.

2  Haga clic en el selector de inserción de la pista 
y seleccione el módulo adicional que desee usar.

Pro Tools incluye un conjunto completo de 
módulos adicionales DigiRack; puede disponer 
de muchos más a través de Digidesign o los 
desarrolladores asociados. 

Módulo adicional Compressor

Para más información acerca de los módulos 
adicionales que se incluyen con Pro Tools, 
consulte la Guía de módulos adicionales 
DigiRack. 

Botón de inserción
Ventana de módulo adicional
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Automatización de mezcla
La automatización de mezcla permite grabar, 
o automatizar, cambios en niveles de pista y 
envío, silenciamientos, panorámico de audio y 
parámetros de módulos adicionales.

Para crear una automatización:

1  Elija Window > Automation Enable.

2  En la ventana Automation Enable, active un 
tipo de automatización (volumen, panorámico 
de audio, silenciamiento, nivel de envío, 
panorámico de audio de envío, silenciamiento 
de envío o cualquier automatización de módulo 
adicional) haciendo clic en el botón pertinente 
para resaltarlo.

3  En cada pista que desee automatizar, 
seleccione el modo de automatización con el 
selector de modo de automatización (Write, 
Touch o Latch). 

4  Inicie la reproducción y, en el transcurso de 
ésta, comience a grabar la automatización 
ajustando los atenuadores y demás controles. 
Pro Tools recuerda todas las acciones realizadas 
en los parámetros activados.

Activación de automatización

Configuración del modo de automatización de una pista



Una vez grabada, la automatización se puede 
volver a grabar, mostrar y editar gráficamente en 
la ventana Edit. 

Mezcla final
El comando Bounce to Disk permite escribir una 
mezcla final en disco, crear un bucle, imprimir 
efectos o rebotar cualquier submezcla. 
Tras haber rebotado la mezcla final al disco, 
se puede emplear otro programa para grabar en 
CD el archivo resultante.

Cuando use el comando Bounce to Disk, 
la mezcla que se guarda en el disco contendrá:

Pistas audibles Se incluyen todas las pistas 
audibles. No aparecen las pistas silenciadas. 
Si aísla una pista o región, en la mezcla rebotada 
sólo aparecen los elementos aislados.

Automatización Toda la automatización activada 
para lectura se reproduce e incorpora a la mezcla 
rebotada. 

Inserciones y envíos Todas las inserciones 
activas, incluidas las inserciones de módulos 
adicionales en tiempo real y de hardware, 
se aplican a la mezcla rebotada.

Automatización del volumen en una pista en la ventana 
Edit

Para más información acerca del uso de la 
automatización, consulte la Guía de 
referencia de Pro Tools.

Vista de pista
Automatización de punto

crítico de volumen
Duración de selección o pista Si realiza una 
selección en una pista, la mezcla rebotada será la 
duración de la selección. Si no hay ninguna 
selección en las pistas, el rebote continuará 
hasta que alcance el final de la sesión.

Para usar el comando Bounce To Disk:

1  Elija File > Bounce to > Disk.

2  Seleccione cualquier salida mono o estéreo, 
o ruta de bus como la fuente para el rebote. 

3  Seleccione el tipo de archivo (por ejemplo, 
WAV), formato (mono o estéreo), resolución 
(por ejemplo, 16 bits) y la frecuencia de 
muestreo (por ejemplo, 44,1 kHz). 

4  Si desea cambiar la frecuencia de muestreo del 
archivo rebotado, elija un valor de Conversion 
Quality.

5  Haga clic en Bounce.

Uso de interpolación o mezcla final

Es necesario utilizar un módulo adicional de 
interpolación al rebotar o mezclar audio a 
una profundidad de bits inferior (por ejemplo, 
al masterizar una sesión de 24 bits a una 
resolución de 16 bits para liberar en un CD 
de audio).

Si está rebotando o mezclando audio para 
reutilizarlo con la misma profundidad de bits 
(por ejemplo, para transferirlo de un sistema con 
capacidad para 24 bits a otro), no es necesario 
que interpole la salida.

Para obtener una reducción de mezclas que 
pueda escribirse en un CD de audio, 
asegúrese de seleccionar WAV, estéreo 
intercalado, 16 bits y 44,1 kHz. 
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Para aplicar la interpolación, se recomienda 
utilizar los atenuadores principales en lugar de 
las entradas auxiliares, ya que las inserciones de 
atenuador principal son post-atenuador. 
Con un atenuador principal, el módulo 
adicional de interpolación procesará los 
cambios en el atenuador de volumen de la pista.

Para interpolar audio para mezcla:

1  Cree un atenuador principal y asígnelo para 
controlar la ruta de salida para el audio que 
desee mezclar o rebotar.

2  Inserte el módulo adicional DigiRack Dither 
(u otro módulo adicional de interpolación) en el 
atenuador principal, detrás de los demás 
módulos adicionales o inserciones de la pista. 

3  En la ventana del módulo adicional de 
interpolación, haga clic en el botón Bit 
Resolution y seleccione la profundidad de bits 
de destino (20 bits o 16 bits).

4  En la ventana del módulo adicional de 
interpolación, haga clic en el botón Noise 
Shaping y seleccione un valor de Noise Shaping. 
Type 1 resulta apropiado para los archivos mono 
y Type 2 o Type 3 son apropiados para los 
archivos estéreo.

5  Elija File > Bounce to Disk para llevar a cabo la 
mezcla.
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Conversión de frecuencia de muestreo 
en la mezcla

Al especificar una frecuencia de muestreo 
distinta para un archivo rebotado (por ejemplo, 
al mezclar una sesión grabada a 48 kHz a 
44,1 kHz para liberar en un CD de audio), 
aparece el valor Conversion Quality en el cuadro 
de diálogo Bounce to Disk.

Hay cinco posibles valores de Conversion 
Quality, que van desde Low (menor calidad) 
hasta TweakHead (mayor calidad). 
Cuanto mayor sea la calidad de conversión de 
la frecuencia de muestreo, mayor tiempo llevará 
la conversión del archivo rebotado.

Para más información acerca del uso de la 
interpolación y la conversión de la 
frecuencia de muestreo al mezclar, consulte 
la Guía de referencia de Pro .
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Configuración de MIDI Studio Setup 
(sólo Windows)
MIDI Studio Setup
Con MIDI Studio Setup (MSS) se configuran los 
controladores MIDI y los módulos de sonido 
conectados al sistema, y se controla la dirección 
de datos MIDI entre el equipo MIDI y Pro Tools.

MSS busca de forma automática interfaces MIDI 
y permite asignar el nombre pertinente para 
cada puerto MIDI en el documento MIDI 
Studio Setup. 

Asimismo, MSS admite nombres de archivo de 
parche que se basan en XML para almacenar e 
importar nombres de parches para dispositivos 
MIDI externos. 

Todas las configuraciones de MIDI Studio Setup 
que se crean en MSS se pueden importar y 
exportar. 

Ventana MIDI Studio Setup

La ventana MIDI Studio Setup está dividida en 
tres secciones. En la parte superior se 
encuentran los controles de la interfaz. En la 
lista Name que hay en la parte izquierda de la 
ventana figuran todos los instrumentos que 
Apéndic
están definidos. En la parte derecha de la 
ventana, en la sección Properties, aparece una 
columna con información detallada sobre los 
parámetros MIDI.

Controles de la interfaz

Create Este botón añade un instrumento nuevo 
a la lista de nombres de instrumentos.

Delete Este botón suprime el instrumento o los 
instrumentos que están seleccionados en la lista 
de nombres de instrumentos.

Import Mediante este botón se importa un 
archivo de MIDI Studio Setup.

Export Mediante este botón se exporta un 
archivo de MIDI Studio Setup.

Ventana MIDI Studio Setup
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Show Duplicate Emulated Ports Si utiliza una 
interfaz MIDI que admita registro de tiempo 
(por ejemplo, MIDI I/O), al seleccionar la opción 
Duplicate Emulated Outputs, en la ventana 
MIDI Studio Setup aparecen los puertos de salida 
de DirectMusic con registro de tiempo y los 
puertos de salida emulados duplicados sin 
registro de tiempo. 

Lista de instrumentos

En la lista de instrumentos constan todos los 
instrumentos que están definidos. Si se 
selecciona un instrumento de la lista, en la 
sección Properties de la ventana aparecen sus 
propiedades.

Sección Properties

En esta sección se modifica la información de los 
instrumentos nuevos o de los que ya están 
seleccionados en la lista de instrumentos.

Cuando se selecciona un instrumento que ya 
está definido en la lista de instrumentos, 
la sección Properties cambia para mostrar las 
propiedades del instrumento seleccionado.

Algunas interfaces MIDI no cargarán ni 
descargarán correctamente los 
controladores a menos que cierre e inicie de 
nuevo Pro Tools. Para más información, 
consulte la documentación que se 
suministra con la interfaz MIDI.

Sección Properties de MIDI Studio Setup
Introducción a ProTools M-Powered
Para definir un instrumento con MIDI Studio 
Setup:

1  Elija Setup > MIDI > MIDI Studio.

2  Haga clic en Create.

3  En el campo Instrument Name, escriba el 
nombre del instrumento y pulse Intro.

4  Establezca un fabricante y un modelo para el 
nuevo dispositivo en los menús desplegables 
correspondientes. (Si los menús desplegables 
Manufacturer y Model no proporcionan un 
nombre para el dispositivo, seleccione None.)

5  En el menú desplegable Input Port, elija el 
puerto de entrada de la interfaz MIDI que se 
conecta a la salida MIDI del instrumento.

6  En el menú desplegable Output Port, elija el 
puerto de salida de la interfaz MIDI que se 
conecta a la entrada MIDI del instrumento.

7  Active los canales MIDI correspondientes 
(1–16) para las opciones Send Channels y 
Receive Channels (son las que determinan los 
canales que deben enviar y recibir MIDI).

Instrument Name

Es el campo en el que aparece el nombre de 
instrumento que define el usuario para el 
instrumento que está seleccionado.

Si no especifica un nombre de instrumento, 
el campo Instrument Name hereda 
automáticamente la información que 
haya en los menús desplegables 
Manufacturer y Model. 



Manufacturer

En este menú desplegable, aparece una lista de 
fabricantes de equipos MIDI. Esta lista se deriva 
de los archivos de dispositivos MIDI que se 
basan en XML. 

Model

Este menú desplegable proporciona una lista de 
dispositivos MIDI, filtrados por nombre de 
fabricante. La lista se deriva de los archivos de 
dispositivos MIDI basados en XML que se 
suministran con la instalación de Pro Tools.

Input Port

En este menú desplegable figura una lista 
con puertos de entrada de la interfaz MIDI. 
Por el puerto de la interfaz MIDI que se define y 
muestra aquí pasan los datos MIDI que se 
envían del dispositivo MIDI externo que se ha 
establecido en el campo Instrument Name a la 
interfaz MIDI.

Output Port

En este menú desplegable figura una lista con 
puertos de salida de la interfaz MIDI. Por el 
puerto que se define y muestra aquí pasan los 
datos MIDI que se envían de la interfaz MIDI al 
dispositivo MIDI externo que se ha establecido 
en el campo Instrument Name.

Para más información, consulte "Admisión 
de nombres de parche MIDI" en la 
página 65.

Para más información, consulte "Admisión 
de nombres de parche MIDI" en la 
página 65.

Si el puerto de entrada se establece en None, 
el instrumento definido no aparece como 
opción en un selector de entrada MIDI. 
Apéndic
Send Channels

En la cuadrícula Send Channels se establecen los 
canales de envío para el dispositivo MIDI que se 
especifica en el campo Instrument Name. 

Receive Channels

En la cuadrícula Receive Channels se establecen 
los canales de recepción para el dispositivo MIDI 
que se especifica en el campo Instrument Name.

Admisión de nombres de 
parche MIDI
Pro Tools es compatible con XML (Extensible 
Markup Language o lenguaje de marcado 
extensible) para almacenar e importar nombres 
de parches para los dispositivos MIDI externos. 
Pro Tools instala archivos de nombres de parche 
MIDI (.midnam) para los nombres de parche 
predeterminados de numerosos dispositivos 
MIDI normales. Dichos archivos constan en 
directorios, ordenados por fabricante, en 
Archivos de programa\Common Files\ 
Digidesign\MIDI Patch Names\Digidesign.

Para importar archivos de nombres de parche MIDI 
a Pro Tools:

1  Compruebe el nombre del dispositivo MIDI 
en la ventana MIDI Studio Setup (consulte 
"MIDI Studio Setup" en la página 63).

2  Compruebe que la salida de pista MIDI esté 
correctamente asignada al dispositivo MIDI.

Si el puerto de salida se establece en None, el 
instrumento definido no aparece como 
opción en un selector de salida MIDI. 
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66
3  Haga clic en el botón de selección de parche 
de la pista MIDI.

4  En el cuadro de diálogo de selección de 
parche, haga clic en el botón Change.

5  En el cuadro de diálogo Open, vaya a Archivos 
de programa\Common Files\Digidesign\ 
MIDI Patch Names\Digidesign\<nombre de 
fabricante> y seleccione el nombre de archivo de 
parche MIDI (.midnam) para el dispositivo 
MIDI.

6  Haga clic en Open.

Botón de selección de parche, ventana Edit

Botón de selección de parche, ventana Mix

Cuadro de diálogo de selección de parche

Botón de selección
de parche

Botón de selección
de parche

Botón Change
Introducción a ProTools M-Powered
El cuadro de diálogo de selección de parche se 
llena con nombres de parches; en la esquina 
superior izquierda de la ventana, aparece el 
menú desplegable Patch Name Bank.

Cuando los nombres de parches se hayan 
importado a Pro Tools, estarán disponibles para 
el dispositivo MIDI en todas las sesiones.

Para borrar nombres de parches:

■ En el cuadro de diálogo de selección de 
parche, haga clic en el botón Clear y haga clic 
en Done.

Cuadro de diálogo de selección de parche con nombres 
de parche

Los archivos de nombres de parches MIDI 
(.midnam) se pueden modificar en cualquier 
editor de textos; también puede usar 
software de biblioteca y editor de nombres 
de parche para crear sus propios nombres de 
parches.



apéndice b

Configuración de AMS (sólo en Mac OS X)
Audio MIDI Setup
Pro Tools reconoce los puertos en la interfaz 
MIDI como genéricos. En Mac OS X, se usa la 
utilidad Audio MIDI Setup (AMS) de Apple para 
identificar los dispositivos MIDI conectados a la 
interfaz MIDI y configurar el estudio MIDI para 
utilizarlo con Pro Tools.

Para configurar el estudio MIDI en AMS:

1  Inicie Audio MIDI Setup (en Aplicaciones/ 
Utilidades).

– o –

En Pro Tools, elija Setup > MIDI > MIDI Studio 
Setup.
2  Haga clic en la ficha MIDI Devices. AMS busca 
interfaces MIDI conectadas al sistema. Si la 
interfaz MIDI está correctamente conectada, 
aparece en la ventana con todos los puertos 
numerados.

3  Para los dispositivos MIDI conectados a la 
interfaz MIDI, haga clic en Add Device. 
Aparece un dispositivo externo nuevo con la 
imagen predeterminada del teclado MIDI.

4  Arrastre el icono del nuevo dispositivo a una 
ubicación adecuada en la ventana.

5  Conecte el dispositivo MIDI a la interfaz MIDI 
haciendo clic en la flecha del puerto de salida 
correspondiente del dispositivo y arrastrando 
una conexión o "cable" a la flecha de entrada del 
puerto correspondiente de la interfaz MIDI.

Audio MIDI Setup (ficha MIDI Devices)
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6  Haga clic en la flecha del puerto de entrada 
correspondiente y arrastre un cable a la flecha 
de salida del puerto correspondiente de la 
interfaz MIDI. 

7  Repita los pasos 3–6 con cada dispositivo MIDI 
durante la configuración.

Para configurar un dispositivo OMS externo:

1  Seleccione el icono del dispositivo externo y 
haga clic en Mostrar información (o haga doble 
clic en el icono del nuevo dispositivo). 

Establecimiento de conexiones de entrada y 
salida MIDI

Para eliminar una conexión, seleccione el 
cable y pulse Supr. Para eliminar todas las 
conexiones, haga clic en Clear Cables.

Icono de dispositivo externo
Introducción a ProTools M-Powered
2  Seleccione un fabricante y un modelo para el 
nuevo dispositivo en los menús emergentes 
correspondientes. (Si los menús emergentes 
Manufacturer y Model no proporcionan un 
nombre para el dispositivo, escriba uno.)

3  Haga clic en la flecha More Properties para 
expandir el cuadro de diálogo y, a continuación, 
active los canales MIDI adecuados (del 1 al 16) 
para las opciones Transmits y Receives. 
(De esta forma se determinan los canales que 
el dispositivo va a utilizar para enviar y 
recibir MIDI.) 

Asignación de nombres a nuevos dispositivos MIDI

 En el caso de Manufacturer y Model, AMS 
hace referencia a uno o más archivos con el 
sufijo ".middev" en el directorio Root/ 
Library/Audio/MIDI Devices. Pro Tools 
instala un archivo que contiene información 
de muchos dispositivos MIDI del mercado, 
"Digidesign Device List .middev". Si el 
nombre del fabricante o del modelo no está 
disponible para dispositivos MIDI externos 
en los menús emergentes AMS Manufacturer 
o Model, puede añadirlos editando el 
archivo .middev en cualquier editor de 
textos (como TextEdit). 



4  Haga clic en la imagen del dispositivo. 
La ventana se amplía para mostrar imágenes 
de varios dispositivos MIDI (como teclados, 
módulos, interfaces y mezcladores). Seleccione 
un icono para el dispositivo. 

Activación de canales MIDI

Selección del icono de un dispositivo
5  Haga clic en OK. 

Los nombres de dispositivo introducidos 
aparecen como opciones de entrada y salida en 
Pro Tools. 

Admisión de nombres de 
parche MIDI
Pro Tools es compatible con XML (Extensible 
Markup Language o lenguaje de marcado 
extensible) para almacenar e importar nombres 
de parches para los dispositivos MIDI externos. 
Pro Tools instala archivos de nombres de parche 
MIDI (.midnam) para los nombres de parche 
predeterminados de numerosos dispositivos 
MIDI normales. Dichos archivos constan en 
directorios, ordenados por fabricante, en 
/Library/Audio/MIDI Patch Names/Digidesign.

Para importar archivos de nombres de parche MIDI 
a Pro Tools:

1  Compruebe el nombre del dispositivo MIDI 
en la ventana Audio MIDI Setup (consulte 
"Audio MIDI Setup" en la página 67).

2  Compruebe que la salida de pista MIDI esté 
correctamente asignada al dispositivo MIDI.

Para utilizar sus propios iconos 
personalizados, puede colocar las imágenes 
TIFF en /Library/Audio/MIDI Devices/ 
Generic/Images; de este modo, aparecen 
como opciones disponibles en la ventana 
AMS del dispositivo.
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3  Haga clic en el botón de selección de parche 
de la pista MIDI.

4  En el cuadro de diálogo de selección de 
parche, haga clic en el botón Change.

5  En el cuadro de diálogo Open que aparece, 
busque el nombre del fabricante 
en/Library/Audio/MIDI Patch 
Names/Digidesign/<> y seleccione el archivo de 
nombre de parche MIDI (.midnam) para el 
dispositivo MIDI.

6  Haga clic en Open.

Botón de selección de parche, ventana Edit

Botón de selección de parche, ventana Mix

Cuadro de diálogo de selección de parche

Botón de selección
de parche

Botón de selección
de parche

Botón Change
Introducción a ProTools M-Powered
El cuadro de diálogo de selección de parche se 
llena con nombres de parches; en la esquina 
superior izquierda de la ventana, aparece el 
menú desplegable Patch Name Bank.

Cuando los nombres de parches se hayan 
importado a Pro Tools, estarán disponibles para 
el dispositivo MIDI en todas las sesiones.

Para borrar nombres de parches:

■ En el cuadro de diálogo de selección de 
parche, haga clic en el botón Clear y haga clic 
en Done.

Los archivos de nombres de parches MIDI 
(.midnam) se pueden modificar en cualquier 
editor de textos; también puede usar 
software de biblioteca y editor de nombres 
de parche para crear sus propios nombres de 
parches.
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